## Contents

1 **Teacher workspace** ................................................................. 4

2 **Student workspace** ................................................................. 9

3 **Daily teacher tasks** ................................................................. 11
   3.1 Demonstrate to a student ........................................................... 11
   3.2 What students can see and do during a demonstration .................. 12
   3.3 Demonstrate toolbox ................................................................. 13
   3.4 Take control of a student computer ............................................ 14
   3.5 Communicate with a student ...................................................... 16
   3.6 Send and collect assignments ................................................... 16
   3.7 Run a test or a survey ............................................................... 18
   3.8 Assist a student ........................................................................ 20
   3.9 Supervise a student’s progress .................................................. 20
   3.10 Create and run a lesson plan ................................................... 22
   3.11 Record and distribute recordings ............................................. 23

4 **Managing the classroom** ......................................................... 25
   4.1 Set up how to manage a class ................................................... 25
   4.2 Invite a student to join a class ................................................... 25
   4.3 Move a student to another class ................................................ 26
   4.4 Using groups .......................................................................... 27
   4.5 Add a teacher ......................................................................... 28
   4.6 Teacher profiles: what they are and why to use them ................... 28
   4.7 Ask a student to be an assistant teacher ...................................... 29
   4.8 Unhide the Student module ..................................................... 29
   4.9 Create a new student account .................................................. 30
   4.10 Student options to prevent teacher control ................................ 30
   4.11 Remotely manage student computers ...................................... 30

5 **Creating tests** ........................................................................... 32
   5.1 Before you create a test or survey .............................................. 32
   5.2 Create a test using the Test Wizard ............................................ 32
   5.3 Create a test using the Test Designer ........................................ 32
   5.4 Question types ........................................................................ 33
   5.5 Tips about creating test questions ............................................. 37
   5.6 Tips about test settings ............................................................ 38
   5.7 Folders .................................................................................... 39
   5.8 Create a survey ....................................................................... 40
   5.9 Advanced test topics ............................................................... 40
      5.9.1 Test scoring ..................................................................... 40
      5.9.2 Question weight exceptions ............................................. 41

6 **Set up student computer permissions** .................................... 42
   6.1 Create a policy ..................................................................... 42
6.2 Define which programs students should be allowed to use ........................................42
6.3 Define Internet access for student computers .........................................................43
6.4 Advanced alternatives to defining access ..................................................................44
6.5 Deny access temporarily .........................................................................................44
6.6 Apply and reset a policy .........................................................................................45

7 Preparing from home .................................................................................................46
  7.1 Export module and data ..........................................................................................46
  7.2 Work on exported module and data .........................................................................46
  7.3 Import data to module ...........................................................................................46

8 Customizing your workspace .....................................................................................48
  8.1 Personalize ...............................................................................................................48
  8.2 Rename, reorganize or hide tabs ...............................................................................49
  8.3 Create a new tab .......................................................................................................49
  8.4 Customize individual commands ............................................................................50
  8.5 Access any command using the keyboard ...............................................................50
  8.6 Restore default settings .........................................................................................51
  8.7 Customize display options .....................................................................................52

9 Daily student tasks ....................................................................................................54
  9.1 Join a class ...............................................................................................................54
  9.2 Communicate with the teacher ...............................................................................54
  9.3 Take a test ...............................................................................................................54
  9.4 Assist the teacher ....................................................................................................55
  9.5 Request help from the teacher ...............................................................................55
  9.6 End remote control ...............................................................................................55
  9.7 Play a recording ......................................................................................................56
  9.8 Unhide the Student module ....................................................................................56
  9.9 What the teacher can do on a student computer ...................................................56

10 Other Teacher tools ..................................................................................................59
  10.1 Netop Screen Image ..............................................................................................59
  10.2 Netop Screen Video ..............................................................................................59

11 Dialog box help information ....................................................................................62
  11.1 Teacher options ....................................................................................................62
  11.1.1 Demonstrate options ........................................................................................62
  11.1.2 Run options ......................................................................................................63
  11.1.3 Attention options ............................................................................................64
  11.1.4 Policy options ...................................................................................................65
  11.1.5 Supervision options ..........................................................................................66
  11.1.6 Session properties ...........................................................................................66
  11.1.7 Class options ....................................................................................................69
  11.1.8 Class Server Setup ..........................................................................................71
  11.1.9 General options ...............................................................................................73
  11.1.10 Audio-Video Chat options ..............................................................................75
  11.1.11 Advanced audio settings .................................................................................75
11.1.12 Connection options ................................................................. 76
11.1.13 Personalize options ............................................................... 78
11.1.14 Protection options ................................................................. 79
11.1.15 Change Protection Password .................................................. 79
11.1.16 Sharing options ..................................................................... 79
11.1.17 Teachers options ................................................................. 79
11.1.18 Toolbar Commands options .................................................. 81
11.1.19 Web Update options ............................................................... 81

11.2 Teacher dialog boxes ................................................................. 82
11.2.1 About NetOp School ................................................................. 82
11.2.2 Audio-Video Chat ................................................................. 83
11.2.3 Chat ....................................................................................... 83
11.2.4 Collect File ............................................................................. 83
11.2.5 Collect files from Students ..................................................... 83
11.2.6 Combine Policies ................................................................. 84
11.2.7 Customize Thumbnail ............................................................ 84
11.2.8 Data Import ........................................................................... 85
11.2.9 Distribute files to Students ..................................................... 85
11.2.10 Edit Policy ............................................................................ 86
11.2.11 File Collection or File Distribution ........................................ 87
11.2.12 File Manager ........................................................................ 87
11.2.13 File Manager Options ........................................................... 89
11.2.14 Lesson Action ...................................................................... 89
11.2.15 Location .............................................................................. 92
11.2.16 Net Addresses ...................................................................... 92
11.2.17 Netop Marker Utility ............................................................ 92
11.2.18 New Test or Survey .............................................................. 93
11.2.19 Port Scan List ........................................................................ 93
11.2.20 Run Program ....................................................................... 93
11.2.21 Student Information .............................................................. 94
11.2.22 Student file location list ....................................................... 94
11.2.23 Style .................................................................................... 94
11.2.24 System Info .......................................................................... 94
11.2.25 Test Designer ....................................................................... 94
11.2.26 Test options ....................................................................... 95

11.3 Student options ......................................................................... 96
11.3.1 Help Request options ........................................................... 96
11.3.2 Protection options ................................................................. 96
11.3.3 Protection Password ............................................................. 96
11.3.4 Student Login options ........................................................... 98

11.4 Student dialog boxes ................................................................. 99
11.4.1 Student window ................................................................. 99

Index ................................................................................................. 100
### 1 Teacher workspace

The Teacher workspace is what you see when you start the Teacher module:

![Teacher workspace](image)

The workspace has two important components:

- Views buttons to left that you use to select what you currently want to see and do within the Teacher module.

- Teacher Ribbon at the top that you use to do the daily teaching tasks, like for example to show the students how to do something, to monitor students to learn whether they have understood an assignment, or to give out tests.

#### The Views buttons

The content in the work area in the middle changes depending on which of the views button you click.

The views buttons are used in different situations:

- Daily teaching situations: Details View, Classroom View and Lesson Plan View.

- Observing students: Thumbnails View and Activity View.

- Preparing lessons: Recordings View and Tests View - and the planning part of Lesson Plans View view.

- Setting up the class for different work situations: Class Setup View.

Each of the views, except for Details View, has a shortcut menu (A shortcut menu
is opened by right-clicking anywhere in the content area with commands that are specific to the view. For example, the Classroom View has a shortcut menu that you can use to change the background bitmap and the Lesson Plan View has a shortcut menu that you can use to manage the individual items that make up a lesson plan.

**Details View**

Displays all the available information about each computer where the Student module has been installed and a student has logged on.

The Details View view can be customized in that additional information can be added for each student:

- On the Options tab, in the Startup group, click General.

**Tip**

In Details View as well as in Classroom View and Thumbnails View, click the small pie icon to toggle between viewing all students computers that are recognized by the Teacher module, and viewing only student computers that are currently logged on.

**Classroom View**

Displays an icon for each of the student computers. The icons can be arranged to reflect the actual seating plan in the classroom.

**Thumbnails View**

Displays a small picture for each of the student computer screens; the picture shows what each student is currently working on.

**Lesson Plan View**

Displays the current lesson plan.

**What is a lesson plan?**

A lesson plan consists of one or more items that the teacher has planned to do or go through during the lesson. For example, during a "French as a foreign language" lesson, the teacher might want to explain about irregular verbs and the five categories they fall into; next the teacher might want to test the students' understanding of the concepts, and finally the teacher might want to discuss the possible test answers with the students.

This might be constructed as a lesson plan with a demonstrate item, a test item, and a communicate item.

When a lesson plan has been created, the teacher can use the Lesson Plan View to see the items that make up the particular lesson and start each item.

**See Also**

Create a lesson plan
Teacher workspace

Recordings View
Displays the recordings that the teacher has previously made.
Recordings can be made from the Recordings View or by clicking Record on the Teach tab.
Recording may show what happens on the teacher's screen or what happens on a selected student's screen. A recording can be played on the teacher and shown to students in a demonstration, or it can be distributed to students to be played on their local machines.

See Also
Record and distribute recordings

Tests View
Displays the tests and surveys that the teacher has previously made. If any of the tests or surveys have been used in a class, the results are displayed on the Results tab.
Tests and surveys are created and managed (edited, renamed, deleted) from the Tests and Surveys tabs in the Tests View.
Tests can be a number of different types, for example an essay or a text completion exercise. A survey on the other hand is a list of questions with one or more answers to each question.
When a test or a survey has been created it can be included as a component in a lesson plan.

See Also
Question types
Create a test using the Test Wizard
Create a test using the Test Designer
Create a survey
Run a test or a survey

Activity View
Displays the student by display name as well as the applications that each student is currently running or the Web sites each student is currently visiting.
Use the shortcut menu to control what the individual student uses, for example to close or hide an application.

Tip
Click the Start and Stop icons to manage activity control.

See Also
Monitor a student's progress

Class Setup View
Displays icons for all students as well as the groups that the teacher has
chosen to divide the class into.

The sole purpose of creating groups in this particular sense is to make selection of student computers easy when activity plans or knowledge levels make it natural to divide the class into fixed groups. For example, you may have a group of students who take a test and you may have another group of students that you want to supervise. Groups may be deleted and created on-the-fly and students can be members of several groups.

Use the shortcut menu to manage (create and delete) groups, to add students to groups, and to activate student computers.

See Also
Using groups

The Teacher Ribbon

The tabs on the Teacher Ribbon at the top of the workspace are grouped according to teaching tasks. The tabs are enabled when one or more students are selected. You can customize the Teacher Ribbon to match you teaching methods and preferences and, for example, make sure that the features you most frequently use are available on the Favorites tab. For details about how to do this, see Personalize.

Favorites tab

The Favorites tab is a collection the most frequently used teaching commands.

In the majority of everyday teaching scenarios you will likely be using only the Favorites tab.

Note

The Stop button is also available on the Teach, Control and Manage tabs; clicking it stops any ongoing session, whether it is a demonstration, attention or communicate session.

Teach tab

The Teach tab commands are grouped in Demonstrate, Run and Record. Each of these three groups includes the entire range of alternatives within an area. For example, the Demonstrate group includes seven alternatives. The most frequently used alternatives are also available from the Favorites tab. The general idea is that you will likely be using the Favorites tab in your daily teaching but can turn to the Teach tab when you need alternatives.

Control tab

The Control tab commands are grouped in Attention, Policy and Supervision. Use one of the Attention alternatives to lock
Teacher workspace

student computer screens, keyboards and mouse. Use the Policy alternatives to apply a policy that defines which programs can be used or which Internet sites can be accessed. Use the Supervision alternatives either to view student computers' screens one at a time, or to remote control student computers. As with the commands on the Teach tab, select commands from the Control tab are also available on the Favorites tab.

Manage tab
The Manage tab commands are focused on managing the classroom in various ways: by setting up workgroups, communicating with students, distributing and collecting files, and restarting or shutting down student computers. As with the commands on the Teach and Control tabs, select commands from the Manage tab are also available on the Favorites tab.

Tools tab
The Tools tab commands are collections of tools related to class management, to Teacher module setup, to preparing for working from home by copying data from the Teacher module, and to update of Netop School software.

Options tab
The Options tab commands are grouped in Teach, Control, Startup, Advanced, Profiles and Themes and are used to set up how the commands in the Teacher module work. The commands in the Advanced group are advanced in two senses: they typically require technical knowledge and they are typically set up once and then rarely changed. This goes for example for Connection which is used to set up how the Teacher and Student modules communicate and for Audio-Video Chat which is used to configure audio.

Profiles and Themes are predefined layout for tabs and color scheme selections.

Note
Personalize in the Profiles group is used to customize the Teacher Ribbon to match your teaching methods and preferences. The personalize options let you completely define both the layout of tabs and groups as well as which commands should be available on each tab and within each group.

Tip
The numbers in the lower right part of the Teacher module status bar indicate:

- The total number of student computers that have ever been connected to the Teacher module.
- The number of connected student computers in the current class.
- The number of selected student computers in the current class.
- The number of available student computers in the Available Students pane in Class Setup View.
2 Student workspace

The basic setup of the Student module determines what options you have access to. There are two basic setup modes:

Visible mode
If the Netop Student module runs in visible mode, you have access to all features in the module. The window may occasionally appear minimized and be represented with an icon in the notification area.

Hidden mode
If Netop Student module runs in hidden or stealth mode, only one option is available: double-click the life belt icon to request help from the teacher.

Overview of menus

File
Click Exit to close down the Student module.

View
Click Toolbar to toggle displaying the student buttons.

Action
Most of the commands on the Action menu are identical to the commands available by clicking the student buttons:

- Join, leave, and rejoin a class.
- Request help from the teacher and cancel a help request that has already been sent.
- End session to stop the current remote control session.

Tools
Options - Define options for all Student module features.
Protection Password - Define password protection settings.
Check for New Updates - Connect to an update server and search for software updates for Student module. Update settings are defined from the Web Update options dialog box.

Run Setup Wizard - Start the setup wizard. The setup wizard has been run at least once to set up the Student module but can be run again at any time to modify settings.
Overview of student buttons

Join Class  If joining a specified class has not been predefined as part of the Student module setup options, click the Join Class button to request to join a class.

Leave Class  Disconnect from the class you are currently in.

Rejoin Class  If you have been signed in to a class and accidentally left it or have been disconnected, click Rejoin Class to enter it again.

Request help  Request help from the teacher. Your request will display on the teacher’s computer.

Cancel help  If you resolve your problem before the teacher has had an opportunity to get back to you, click the Cancel Help button.
3 Daily teacher tasks

3.1 Demonstrate to a student

Demonstrating is a widely used teaching method and Netop School offers a number of ways to demonstrate: by showing what you are doing on your desktop, by showing movies or by showing a recording of how some task is done.

확장 아이콘: Tip: To allow student to interrupt during a demonstration
1. On the Options tab, in the Teach group, click Demonstrate.
2. Under On Receiving Students, select the Launch Toolbox check box.

확장 아이콘: Demonstrate by showing all activity on your desktop
1. Select one or more student computers.
2. On the Favorites tab, in the Demonstrate group, click Entire Screen.

All activity on your desktop will be displayed on the selected student computers and the student computers' keyboard and mouse are locked. You can choose to set up student computers to be allowed to interrupt during demonstrations.

To end the demonstration, click the End Session button on the Screen Control panel.

확장 아이콘: Demonstrate by showing a movie
A movie can be a good and efficient way to supplement other teaching methods. Videos are broadcast simultaneously to all student computers, and the replay function is controlled from the teacher's computer. Films can be paused at any time, and student computers can be locked.

1. Select one or more student computers.
2. On the Favorites tab, in the Demonstrate group, click Media file and then click Browse to locate the media file you want to show.

The file called movie which is readily available in the list of media files is a sample demonstration movie.

When the preparation is complete, the movie is ready for playback on the student computers and a toolbox with play control buttons is displayed on the Teacher screen.

3. Click the Play button to run the movie and the End Session to stop the movie demonstration session.

Note
If the movie file you want to show is substantial in size, you might improve performance dramatically by placing the file on a shared network drive and run the demonstration from there rather than copying the file to student computers.

To play a movie from a shared network drive, you must specify the entire path using \\ without using any drive mappings, for example:

\\server\share\teachershare\largemoviefile.mpg
Daily teacher tasks

Note that a video can be created using the Netop Screen Video Tool. For more information, see Netop Screen Video.

**Demonstrate by showing a recording**

A demonstration can also consist in showing the students how to do a certain task; a simple example could be: "How to change the default font in Word". You can record how to do this and then show the recording on the student computers.

1. Prepare what you are going to record and rehearse it.
2. On the **Favorites** tab, in the **Record** group, click **Record** to record the activity on your screen.
   
   For more information about recording, see Record and distribute recordings.
3. To end the session, click the **End Session** button on the recording control panel and save the recording.
4. On the **Teach** tab, in the **Demonstrate** group, click **Recording** and then click the name of the recording.

The recording is complete. And you are ready to assist your students by showing them the recording.

**See Also**

What students can see and do during a demonstration

### 3.2 What students can see and do during a demonstration

By default, keyboard and mouse are both locked on a student’s computer when you do a demonstration, regardless of the demonstration method you use.

Depending on the situation, you may want to allow students to interrupt a demonstration. You set this option from the **Options** tab:

1. On the **Options** tab, in the **Teach** group, click **Demonstrate**.
2. Under **On Receiving Students**, select the **Launch Toolbox** check box.

When this option is selected, students see a small control panel during a demonstration:

![Control Panel Image]

Using the control panel buttons the students can:

- Request the microphone. Note that the button is only active during an audio chat session.
- Ask for help by sending a help request to the teacher; see Assist a student for information about how to handle a help request.
- Request control of their mouse and keyboard so that they run the the present demonstration. You will be notified that a student has requested to temporarily have mouse and keyboard unlocked in the teacher control panel.

Whether the students have a control panel or not, you can also choose to temporarily give a student control of mouse and keyboard:

- On the teacher control panel, click the **Pass the Chalk to Student** button and select
Daily teacher tasks

the student who should have control.

Tip
Press the Ctrl key on the Teacher computer to suppress any input from Student computer keyboards and mouse.

3.3 Demonstrate toolbox

When you have started a demonstration session by choosing one of the seven demonstrate (The demonstrate options are: Entire Screen, Selected Screen Area, Media File, Media File on the Web, Recording, Specific Monitor, Student Screen) options on the Teach tab, the Teacher module environment disappears from your screen. Instead a small toolbox with relevant commands opens to enable you to control the session. The toolbox commands differ slightly depending on the session type but the left-most button can always be used to end the session.

Below is an example of the toolbox that is available when you have clicked Entire Screen:

![Screen Control](image.png)

All buttons have a tooltip that explains what the specific command does.

Description of commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Session</td>
<td>Close the toolbox and end the demonstrate session.</td>
</tr>
<tr>
<td>Toggle full screen/window on Teacher</td>
<td>Switch between showing the student screen in full screen mode and in window mode on the teacher computer.</td>
</tr>
<tr>
<td></td>
<td>This command is available only when a student screen is used for the demonstration. The startup mode for a Student Screen demonstration is defined from the Options tab:</td>
</tr>
<tr>
<td></td>
<td>1. On the Options tab, in the Teach group, click Demonstrate.</td>
</tr>
<tr>
<td></td>
<td>2. Select or clear the Hide Teacher Main Window and Show demo in fullscreen at Startup check box.</td>
</tr>
<tr>
<td>Start/stop Speak</td>
<td>Click to start or stop transfer of microphone input and any application sound from the computer being demonstrated to the computers on the receiving end.</td>
</tr>
<tr>
<td></td>
<td>Tip</td>
</tr>
<tr>
<td></td>
<td>If sound transfer does not work, review the sound recording setup in Windows (Depending on your</td>
</tr>
</tbody>
</table>
Daily teacher tasks

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| computer setup                | you open the volume control from the notification area and on the Options menu click Properties. Click the Recording option to see recording volume controls. Netop School expects to find a sound recording device named **Wave Out Mix** or **Stereo Mix**. If this is not available on both teacher and student computers, add this section to the netop.ini file:  

```
[AUDIO]
Sound_Mix=<Recording sound mix name>
```

If the computer sound device does not support recording sound mix, sound transfer will not work. Sound transfer and audio-video chat cannot run at the same time. |
| Start/Stop Audio-Video Chat   | Click to start or stop an audio-video chat session with the student computers that take part in the demonstrate session.                       |
| Start/Stop Netop Marker Utility| Click to start or stop **Netop Marker Utility** that you can use to mark or magnify an area on the demonstrated screen.                          |
| Toggle full screen/window on Student | Switch between showing the teacher computer's screen in full screen mode and in window mode on the student computers.  
The startup mode is defined from the **Options** tab:  
1. On the **Options** tab, in the **Teach** group, click **Demonstrate**.  
2. Select or clear the **Show demo in full screen at Startup** check box. |
| Pass the Chalk to Student     | Click to hand over control of keyboard and mouse to the selected student computer. The student can move the mouse pointer and use the keyboard exactly as if the student were sitting in front of the teacher computer.  
The student can pass back control or the teacher can click to get the control back. |

### 3.4 Take control of a student computer

Occasionally it may be useful to be able to lock the screen, the keyboard and the mouse on selected student computers. The easiest way to do this is to:  
1. Select the student computers to lock.
2. On the **Control** tab, in the **Attention** group, click **Default Image**.

The student computer screens now display the default bitmap included in Netop School. Unlock student computers by clicking the **Default Image** button again.

Other display alternatives for the student computer screens are available, though. When you lock a screen, you can decide what to display on the screen while locked. You can choose to display:

- An image file of your own choice.
- A short text message, for example: "The test is tomorrow morning at 8 A.M."
- A longer text message in the form of a text file.
- A Web site.

**Tip**

You can always use the **Stop** button to release any control of student computers, regardless of the display alternative you used to lock the student computers.

---

**Overview of different display options on locked student screens**

The **Attention** group on the **Control** tab has five different display options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Image</td>
<td>Display the default bitmap included in Netop School.</td>
</tr>
<tr>
<td>Image File</td>
<td>Display a bitmap on all student computers.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The bitmap file must be in the same location on all computers.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip: how to distribute a file</strong></td>
</tr>
<tr>
<td></td>
<td>Use <strong>Distribute Files</strong> or <strong>File Manager</strong> on the <strong>Files</strong> menu to copy a bitmap to the same location on all student computers.</td>
</tr>
<tr>
<td></td>
<td>Consider creating a folder on all student computers called &quot;Student files&quot; or something similar.</td>
</tr>
<tr>
<td>Text</td>
<td>Display a text on all student computers.</td>
</tr>
<tr>
<td></td>
<td><strong>To type a text to display:</strong></td>
</tr>
<tr>
<td></td>
<td>1. On the <strong>Options</strong> tab, in the <strong>Control</strong> group, click <strong>Attention</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Under <strong>Show attention</strong>, click <strong>Text</strong> and set the appropriate options.</td>
</tr>
<tr>
<td>Text File</td>
<td>Display a text file on all student computers.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The text file can have a maximum length of 255 characters. Additional characters are ignored.</td>
</tr>
<tr>
<td></td>
<td><strong>To type a text to display:</strong></td>
</tr>
<tr>
<td></td>
<td>1. On the <strong>Options</strong> tab, in the <strong>Control</strong> group, click <strong>Attention</strong>.</td>
</tr>
</tbody>
</table>
### Daily teacher tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.</td>
<td>Under <strong>Show attention</strong>, click <strong>Text File</strong> and set the appropriate options.</td>
</tr>
</tbody>
</table>

**Web**

Display a Web page on all student computers.

**Note:** The Web page displays with no address bar and students are not able to interact with the Web page; they can view only.

To select a Web page to display:

1. On the **Options** tab, in the **Control** group, click **Attention**.
2. Under **Show attention**, click **Web Page** and set the appropriate options.

---

### 3.5 Communicate with a student

Depending on your needs and on the technology available, Netop School offers a number of ways in which you can communicate with a student:

#### Send a message

1. Select the student you want to send a message to.
2. On the **Manage** tab, in **Communicate** group, click **Send Message**.
3. Type the text you want to send and click **Send**.

The message displays on the student computer. The student cannot reply or send new a message. If you want the student to reply, use one of the chat options.

#### Chat with a student

1. Select the student you want to chat with.
2. On the **Favorites** tab, in **Communicate** group, click **Chat**.
3. In the chat dialog box, type your message and click **Send**.

The student can reply and the chat session remains open until you close it by clicking **End chat**.

#### Chat with a student using sound and video

1. Select the student you want to chat with.
2. On the **Manage** tab, in **Communicate** group, click **Audio-Video chat**.

Depending on the hardware available, you can now use your microphone to talk to the student and if Video has been enabled, you can see each other in the right-hand side of the dialog box.

---

### 3.6 Send and collect assignments

You can use the Teacher module to distribute assignments and other types of documents to students. And when the students have completed their assignment, you can collect the assignment from the Teacher module as well.

Before you start sending and collecting assignments, it is a good idea to create a folder
on each student computer for new assignments and a folder for completed assignments, for example:

C:\New assignments - this is where you will place new assignments for students to pick up.

C:\Completed assignments - this is where student will place completed assignments for you to pick up.

**Send an assignment**

1. On the Manage tab, in the Files group, click Distribute.

   The default setting is that the Distribute Files Wizard opens to lead you step-by-step through the send process. If you do not want to use a wizard to distribute files, click the Advanced button in the second wizard dialog to open a dialog box where you can make all three selections. To go back to the wizard, click the Wizard button in the Distribute files to Students dialog box.

2. In the first wizard step, click Add files to locate the file or files you want to distribute.

3. In the second wizard step, select the students or groups to receive the file.

4. In the third wizard step, select where the file should be placed on the student computers and click Distribute.

   The file will be placed in the same location on all student computers and this is where it is useful to have a folder created beforehand.

   If you choose not to use the wizard, you make all selections in one dialog box; and you get the added option of being able to created a destination folder as part of the process.

**Collect an assignment**

1. On the Manage tab, in the Files group, click Collect.

   The default setting is that the Collect Files Wizard opens to lead you step-by-step through the collect process. If you do not want to use a wizard to distribute files, click the Advanced button in the second wizard dialog to open a dialog box where you can make all three selections. To go back to the wizard, click the Wizard button in the Collect files from Students dialog box.

2. In the first wizard step, click Specify files to locate the file or files you want to collect.

   Note that you can choose to delete the file or files on the student computers once you have collected them. This is useful because the students will then be aware that you have collected the files and they can no longer make any updates.

3. In the second wizard step, select the students or groups that you want to collect files from.

4. In the third wizard step, select where the file should be placed on the your computer and click Collect.

   Like with the distribute process: if you choose not to use the wizard, you make all selections in one dialog box.
Daily teacher tasks

Tip: Distribute files directly from Windows Explorer
Files can be moved directly from Windows Explorer to the selected students in the Teacher interface using a drag-and-drop operation. This opens the Distribute files to Students window to allow you to decide the destination for the files.

If this is your favorite method and you always use the same destination, selecting the Use this destination when files are dropped and don’t prompt with this dialog check box will distribute files directly to the selected destination and skip opening the window.

3.7 Run a test or a survey
Test and surveys share a number of characteristics in Netop School and are started and managed in similar ways. The difference between the two is that a test can have questions of 10 different types whereas a survey is always multiple choice. The description below covers both tests and surveys.

Start a test or a survey
• In Tests view, select the relevant test or survey and drag it to the group that you want to take the test or survey.

The test or survey starts on the student computers.

Alternative ways to start a test or a survey
In addition to starting tests or surveys from Tests view, a test or a survey can also be started in different ways from Details view.

1. In the Details view, select a student or a groups of student.
2. On the Teach tab, in the Run group, click Run Test and then click the relevant test in the submenu.

Or on a single student:
• In the Details view, right-click a student, point to Run a Test on this Student and click relevant test in the submenu.

While the test or survey is running...
Once a test or a survey is running, the Netop School Test Monitor automatically starts to allow the teacher monitor student progress: Are they having trouble, showing slow progress, experiencing computer problems?

The Test Monitor compares the students’ answers with the correct answer, as given by the teacher while creating the questions. If the questions were prepared with scores these are also continuously and shown in the Test Monitor:

- Not viewed
- Viewed - not answered
- In progress
- Answered correctly
Double-clicking a student record will allow you to observe the student computer’s screen. From there you are also able to take over control of the student.

Use the three Test Monitor control buttons to Start, Pause or Stop the current test. The drop-down list next to the control buttons is useful when you have several simultaneous tests running. Having different tests running at the same time might be useful if you wanted to give the students in a class differentiated tests.

When the test or survey completes

When the students have completed a test or a survey, a test report opens summarizing the students’ results.

You can print a class summary and a student summary:

- On the Test Report File menu, click Print Class Summary or Print User Summary.

If you prefer to process the test results in another application, for example in Microsoft Office Excel, you can export the test result to a comma-separated values file (.csv), to a Tab-separated file (.tab), or to a file in Excel format (.xls). You can export from the Test Report File menu, or from the Results tab in Tests View:

- On the Test Report File menu, point to Export to and then click CSV file, TAB file or XLS file.
  - OR -
- In Tests View, on the Results tab, right-click a results file and on the shortcut menu click Export to CSV file, Export to TAB file or Export to XLS file.
Daily teacher tasks

3.8 Assist a student
Netop School offers different ways in which the teacher can assist a student, for example by:

- Giving a demonstration, for example by showing all activity on your desktop.
- Starting a chat, with or without video.
- Sending a message.

The teacher can offer assistance at any time.

Assistance can also be as a response to a student request: the student can send a help request that will appear in the teacher's details view. In case the Netop Teacher module is not currently on top, a small life belt icon is also shown in the notification area on the teacher's computer.

Respond to request for assistance
To respond to the student's request for assistance the teacher can:

- Right-click the student in the Details view, and click the appropriate command.

Depending on the nature of the student's request, the most suitable command could be Remote Control this student, Chat with this student, Audio-Video Chat with this student, or Send Message to this student.

When the student has been given required assistance, right-click and choose Clear Help Request to remove the request and the icon in the notification area.

See Also
Demonstrate to a student
Communicate with a student

3.9 Supervise a student's progress
Netop School offers different ways in which the teacher can supervise a student's progress, for example by:

Observing which applications and Web sites the students in the class are using.
1. Click the Activity button to switch to Activity View.
2. Click the Start Activity Control button to see which applications and Web sites the students in the class are using.

Tip
Only applications that have active windows on the desktop are listed. Click Task manager on the Activity View menu to see all running applications.

The top half of the Activity View lists all active student computers, which applications and websites they are running and which one is currently active. Two tabs offer a choice for viewing applications or Web sites. Use the shortcut menu (Right-click to open a shortcut menu) to temporarily hide an application on a student computer or to close an unwanted application.

The lower half of the Activity View lists all the different active applications and, if
the Internet is used, which sites are active. If more students are using the same program (same version and same OS-platform) only one icon will be listed but the number of students appears beside it as well as the names of the users. Where the top half of the Activity View includes options to deal with individual student computers, the lower half, **Active Applications and Sites**, lets you control which applications are allowed to run on all the student computers connected to the class

### Observing activity of individual students, one at a time.

- **On the Favorites tab, in the Supervision group, click Observe Students.**

  This will display the screen of a student computer; the display will automatically change to that of the next student. In this way you can browse through and see what each student is engaged in.

  Set the time period in which you see each student computer screen from the Options tab: in the Control group, click Supervision.

  While browsing through student computer displays, a control panel is available to let you for example end the session, scroll to the next student, switch to full screen display, or take screen shot of the student computer screen.

### Observing activity for the whole class by a thumbnail view of all student computers.

- **Click the Thumbnails button to switch to Thumbnails View.**

  The thumbnail view gives an overview of all student activity that makes it easy to see if a student is working on a wrong page or is not making any progress.

  To follow a student more closely, double-click the student thumbnail. This will open the student desktop on the teacher screen and enable you to remote control the student computer.

### Using remote control to take over a student’s computer

Using remote control to take over a student’s computer means that you can work on the student computer as if you were sitting in front of it.

You can start remote control in several different ways, for example:

- **In Thumbnails View,** double-click the thumbnail for the student computer that you want to control.

  OR

- **In Details View,** click the Control tab and then click Remote Control in the Supervise group.

  By default the student computer and the teacher computer share the keyboard and mouse control. To block the student from using the keyboard and the mouse, click the Lock Keyboard and Mouse button on the toolbar.

  The toolbar offers a number of other options, for example to restart the student computer, to copy the clipboard from the student computer or to do a print screen of the student computer.

**Tip**

Remote control is a one-to-one session between you and one student computer.
However, you can start several remote control sessions one at a time and run them in parallel.

3.10 Create and run a lesson plan

As the term implies, a lesson plan is a plan for the contents of a specific lesson. A lesson plan consists in one or more tasks that the teacher has planned for the class taking the lesson; these tasks are called lesson actions.

Note that an item to be added as a lesson action must exist before it can be added to a lesson plan. For example, if a test is to be one of the lesson actions, the test must be created in Tests View before it can be added as a lesson action.

Tip

A lesson plan is typically created when you are offline, for example when you have exported module and data and are preparing for a class at home. To be able to select which students or groups that should be involved in the lesson plan, student information must be saved when the class is offline. This is automatically done if the option **Save new students between classes** has been selected:

- On the **Options** tab, in the **Startup** group, click **General**.

Creating a lesson plan consists in two steps: creating the lesson plan and adding one or more lesson actions to the lesson plan.

![Create a lesson plan](image)

1. Click the **Lesson Plan** button to open **Lesson Plan View**.
2. On the **Lesson Plan View** toolbar, click the down arrow button to open a menu and click **New**.
3. Type a suitable name for the new lesson plan and click **OK**.

You have now created a lesson plan and the next step is to add one or more teaching actions.

![Add a lesson action to a lesson plan](image)

1. In **Lesson Plan View**, select the lesson plan you want to add an action to.
2. Right-click the lesson plan window and click **Add**.
3. In the **Lesson Action** dialog box, select the action you want to use and set the options relevant to that action and select the group who should be involved in the action. Also, type a name and a description.

Note that the actions are identical to the ones available on the **Teacher** buttons. Including an action in a lesson plan simply means that you can execute the actions in a pre-defined sequence. A typical sequence of lesson actions could be:

1. Demonstrate - the teacher shows how something works or is done to the students.
2. Run test - the teacher gives the students a test to verify that they have understood the concepts.
3. Communicate - the teacher chats with the students to discuss the outcome of the test and the next steps.

**Tips**

- When you add one of the alternatives from the **Attention** group as a lesson action, it might be a good idea to add **Stop** as the lesson action following the **Attention** lesson action.
- Some commands, like for example **Log Off** or **Shut Down**, make sense only as the last lesson action in a lesson plan.

**Manage lesson plans**

- To create, copy or delete a lesson plan, click the down arrow button to open a menu and click **Manage lesson plans**.

When you copy a lesson plan, the copy includes all teaching actions from the original. Right-click and then click **Edit** in the **Lesson Plan View** to modify each action.

**Run a lesson plan**

1. In **Lesson Plan View**, select the lesson plan you want to use.
2. Right-click the first action and click **Execute**.

Alternatives are to:

- Double-click the action.
- Click the **Execute next lesson action** button in the **Lesson Plan View** toolbar.

When a lesson action has been run, a green check mark is automatically added next to it. To run a lesson action again, right-click it and click **Mark as undone**.

**3.11 Record and distribute recordings**

A recording is an alternative to a demonstration: where a demonstration is live and in real time, a recording is a prepared sequence of steps or actions that the teacher prepares for the students to view on their computers.

**Create a recording**

1. On the **Favorites** tab, in the **Record** group, click **Record**.

The recorder starts immediately and all actions on your desktop are now recorded. The recorder control panel automatically displays; use it to pause during the recording if needed.
2. Go through the steps that you want to record and click the **Stop recording** button to end the recording session.
3. Type suitable name for the recording and click **OK** to save.

All recordings are available from the **Recordings View**.

**Distribute recordings to students**

The simple way to distribute recordings is to use a drag-and-drop operation from the
Daily teacher tasks

Recordings View:

- Select the relevant recording and drop it to the All group, or to any other group.
  The moment you drop the recording to a group, it becomes available to all students in that group.

Tips

- Send the students in the group a message telling them to open the recording: On the Manage tab, in the Communicate group, click Send Message.

- The recording files can also be located outside the School environment. Depending on the operating system you use, the default folder could for example be: C:\Documents and Settings\<user>\Application Data\Danware Data\Netop School\Teacher\Screcord

See Also

Netop Screen Image
Netop Screen Video
4 Managing the classroom

4.1 Set up how to manage a class

A class is the framework in which a lesson or a test takes place. When the Teacher module is running, one class is always the active, current one. You can define whether the Teacher module should start with the same class as the active one by default, or whether you want to choose which class should be the current one when you start the Teacher module:

1. On the **Options** tab, in the **Startup** group, click **Class**.
2. Select the **Always Select Class at Startup** check box to have the Teacher module open a list of available classes on startup.

Whether you prefer this setting or the default setting likely depends on the number of classes you have defined in Netop School.

**Options for students joining a class**

You can also set up options for student computers joining the class:

1. On the **Options** tab, in the **Startup** group, click **Class**.
2. Select the **Notify when Students join late** check box to receive a message in the notification area when a student computer joins a class which is already in progress.

When a demonstration, an observe session or a chat is taking place, you may or may not want to allow student computers to join:

- In the **Auto join** list select not to allow student computers to join, to have student computers join automatically, or to be prompted when a student computer joins.

When student computers join, you can choose to limit what they can do initially:

In the **Startup Policy** list, select one of the extreme policies - **Deny All** or **Allow All** - or a policy you have defined.

**See Also**

[Create a policy](#)

4.2 Invite a student to join a class

How a student computer should behave with respect to joining a class is defined on each student computer; typically all student computers have identical setup, though.

These are the ways a student computer can behave when starting up:
### Managing the classroom

<table>
<thead>
<tr>
<th>Connect to a class</th>
<th>The student computer automatically connects to a named class when starting up. This is the default setting.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse for classes</td>
<td>The <strong>Browse for classes</strong>, <strong>Select a class</strong> and <strong>Use Class Server</strong> options leave it up to the student computer to choose a class to join.</td>
</tr>
<tr>
<td>Select a class</td>
<td>The browse and select options are for joining classes in progress while the <strong>Class Server</strong> (Class Server is an advanced module that is part of the NetOp Class Management package. For additional information, see <a href="http://www.netop.com/netop-389.htm">http://www.netop.com/netop-389.htm</a>) option can also be used to join upcoming classes.</td>
</tr>
<tr>
<td>Use Class Server</td>
<td>The student computer is available on the network and the teacher can invite such student computers to join a class.</td>
</tr>
<tr>
<td>Be available for any class</td>
<td>This option leaves it up to the teacher to ask student computers to join a class.</td>
</tr>
</tbody>
</table>

**Tip**

On the teacher computer, verify this setting on the **Options** tab: in the **Startup** group, click **General**.

The check box **Get available students** should be selected to have available students shown in the **Available Students** list in **Class Setup View**.

---

**Invite an available student**

1. In **Class Setup View**, right-click a student computer in the **Available Students** (An available student is a student who does not automatically join a class) list or invite all by clicking the small **Invite available students** button.

2. In the **Invite Students** dialog box, type an invitation text and click **OK** to send the invitation.

When the invitation displays on the student computer, the student can accept or decline.

---

**4.3 Move a student to another class**

If a student has joined the wrong class, you can move the student to another class.

1. In **Classroom View**, right-click the student you want to move and click **Move this Student to another class**.

2. In the **Move Student to Class** dialog box, select the name of the relevant class and click **Move**.

You can also move a student to another class without necessarily switching to **Classroom View**:

- Select the student computer you want to move and on the **Manage** tab, in the **Commands** group, click **Move**.
Note
Moving a student from one class to another using the class name requires the two classes to be located on the same subnet. If you need to move the student computer to a class which is on a different computer or on a different subnet, you must select the Teacher IP address or DNS name option and type this information. The available classes will be detected automatically.

4.4 Using groups

Groups are a way to split up students in a class, for example according to projects students are currently working on. When students are in a group, they are managed as an entity and it is easy to run a test, do a demonstration or send a message to all students in the group.

Use Class Setup View to see which students belong to which groups, to create groups and to add students to groups.

Create a group

There are several ways to create a group:

From Class Setup View:
1. Right-click anywhere in the top pane and on the shortcut menu, point to New and click Create group.
2. In the New Folder dialog box, type a name for the new group.

From Details View, Classroom View or Thumbnails View:
1. Right-click anywhere in the Groups pane and on the shortcut menu click Create group.
2. In the New Folder dialog box, type a name for the new group.

Note
Groups are available only within the class where they were created.

Add students to a group

There are several ways to add a student to a group:

From Class Setup View:
1. Right-click the group that you want to add students to and then click Add student to group.
2. In the Student List dialog box, select one or more student and click OK to add them.

From the Details View:

- Drag students into the group.

Delete a student from a group
Managing the classroom

- In Class Setup View, right-click the student and click Delete.

4.5 Add a teacher

1. On the Options tab, in the Advanced group, click Teachers.
2. Select the Use Teacher Profiles check box.
3. Click Add User and type a user name and a teacher name.

   The User name is your identification in the system while Teacher name is used to identify you during a chat session.

Individual settings like folder choice, groups and bitmaps are saved to the profile. You can create as many teacher profiles as you need in the Teacher module.

Note
Once you have defined the first teacher profile, you need to log on with that profile to create the following profiles.

4.6 Teacher profiles: what they are and why to use them

When you use your own user name and password to log on to Windows, your personalized Netop School settings are automatically saved under your Windows user profile (This could for example be: C:\Documents and Settings\<initials>\Application Data\Danware Data\NetOpSchool\Teacher). These settings include startup options like for example class name and startup policy as well as display settings like for example theme and tab names.

If the computer environment where Netop School is installed has not been set up with individual Windows users but with one account that all teachers use, Netop School settings are saved under that one user profile. This means that all users must use the same settings - unless teacher profiles are used.

Teacher profiles are settings for each individual user of a Teacher module, including authentication by user name and password.

User name and password may be set up to be identical to the user name and password used to log on to Windows. In cases when all users log on to Windows using identical name and password, choosing Windows authentication to log on to Netop School should not be selected. For a description of the relevant selections when creating teacher profiles, see Teacher options.

When a user name and a password has been defined in Netop School, the user is prompted for name and password when starting the Teacher module.

In addition to being able to specify user name and password for one or more user, defining teacher profiles has other advantages: user settings like folders, groups, tests, and bitmaps are automatically saved regularly.

Note
Once you have defined the first teacher profile, you need to log on with that profile to create the following profiles.
Other differences when teacher profiles have been defined

- You can log off from the Teacher module using the Change Teacher command on the Tools tab. This command is available only when teacher profiles are used.

- Typically, the name of the current class is shown in title bar. However, if teacher profiles are used, the teacher profile user name is shown in the title bar instead of the class name.

4.7 Ask a student to be an assistant teacher

When you are creating a workgroup, you can appoint a student to head the workgroup and function as a group leader. You can create more workgroups at the same time.

1. From Details View, select the student computers that should be part of the workgroup.

2. On the Manage tab, in the Workgroup group, click Workgroup.

3. In the Create Workgroup Session dialog box, select a student to head the workgroup and click OK.

The selected student computer functions as a teacher computer and has the same features and functions as the main teacher - unless restrictions have been defined by the main teacher. On the student computer that functions as a teacher computer, the Student module minimizes and appears only as an icon in the notification area, and the Teacher module opens.

The students in the workgroup are temporarily disconnected from the main teacher's class and join the Assistant Teacher's session.

Information about Assistant Teachers and workgroup members can be seen in the student views (The student views are: Details, Classroom and Thumbnails): Assistant Teachers are displayed as connected with workgroup name; workgroup members are displayed as disconnected but with workgroup name.

End a workgroup session

To end the workgroup session and release the student from being an assistant teacher:

- In one of the three student views, right-click a student computer in the workgroup session and then click Stop Workgroup Session.

The student computers now reconnect to the main teacher's class.

4.8 Unhide the Student module

If a student computer has been set up to run in Stealth mode and you need to change this, start a remote control session.

1. Select the student computer in question.

2. On the Control tab, in the Supervision group, click Remote Control.

3. On the remote controlled student computer, find the executable file: C:\Program Files\Danware Data\Netop School\STUDENT\Showhost.exe

4. Double-click Showhost.exe and the Student module will be restored to normal mode.

5. On the student computer, run the Student Setup Wizard and make the necessary changes.
Managing the classroom

4.9 Create a new student account

Typically student computers are set up to join a class when they start up. Alternatively they can be set up to be available for any class and be listed as such on the teacher computer. When either of these options are set, student computer accounts are automatically created.

When student computers do not automatically join, you can manually create a user account from Class Setup View:

1. Right-click anywhere in the Class Setup View area and on the shortcut menu point to New and then click Create Student.

2. As a minimum, type Student Login Name and Computer Name or Windows Login Name.

   Student Login Name is required because when a student computer connects, it will be identified as an existing account only if the Student Login Name matches that of an existing account.

Other ways to create a new student account

- On the Options tab, in the Startup group, click General, and select the Save new students between classes check box. When student computers join a class, the student computer information is saved.

- Copy student computers from the Available Students pane, or use a drag-and-drop operation to move student computers from the Available Students pane.

4.10 Student options to prevent teacher control

When the Student module is running in normal mode so that students have access to commands and options in the Student module, student also have access to limiting what the teacher can do in the Teacher module with respect for example to locking student computers, supervising, distributing and collecting files, and defining access to the Internet and to the use of programs.

Restrictions on teacher control are defined in the Protection dialog box in the Student module:

- On the Tools menu, click Options and then double-click Protection.

To prevent students from restricting teacher control, choose one of the following ways:

- Run the Student module in hidden mode. This is a startup option on each Student: On the On the Tools menu, click Options and then double-click General. This means that students do not have access to the Student module user interface at all except to request assistance.

- Define a protection password and make sure that this password is not shared with the students. On the Tools menu, click Protection Password.

4.11 Remotely manage student computers

Student computers can be remotely controlled from a Netop Remote Control Guest. This means that a second teacher or an IT administrator can take control of a student computer to assist with any problems, even while the class is in session.

The feature is standard in the Student module and no special installation is required; the only required setup is to enable access and to define a password.
The computer used to remotely control student computers must have Netop Remote Control Guest installed; the Guest license is a separate one which is not included with the Netop School license. In addition, a TCP/IP communication profile must be created and the communication profile set up to use port 1971.

What does this mean to the teacher?

The teacher still has full control of the class and the student computers in the class. This means that when a teacher is observing a student computer or remotely controlling a student computer, then the teacher actions have precedence and the IT administrator cannot remotely control the student computer.

On the other hand, if the IT administrator is controlling a student computer, then the teacher will see a message saying that a remote control session is currently not possible. When the IT administrator ends the remote control session, the teacher can take over again.

Enable remote control of student computers

On the student computers to be remotely controlled from a Netop Remote Control Guest, remote control access must be enabled and a password must be defined.

This can be done from the Setup Wizard that runs automatically on first startup, or it can be done from the tools menu:

1. On the Tools menu, click Options and then double-click Protection.
2. Select the Enable Access check box and type a password.

When the IT administrator later wants to remotely control the student computer, the administrator must type the password before being granted access.

This is all the setup that is required on the student computer.

Required setup on the Netop Remote Control Guest computer

On the Netop Remote Control Guest computer, a TCP/IP communication profile must be created with a communication port that matches the one used by Netop School:

1. In the Communication profile section, click the New button.
2. In the Communication Profile Edit dialog box, type a name for the profile, and then click the Advanced button.
3. Clear the Use default port numbers check box and type 1971 in both fields.

This is all the setup that is required on the guest computer.
Creating tests

5 Creating tests

5.1 Before you create a test or survey

Before you create a test or a survey, you might want to consider whether the test or survey and the results should be available to all teachers using Netop School or whether they should be available to you only.

By default, tests and surveys are saved to a public folder and are visible to all teachers. If you want to store a test and the test results so that only you can see them, switch to the Private Tests folder before you create the test.

You can also create a folder of your own. This folder can either be private - if it is created where only you have access, for example under your Windows user profile - or public - if it is created for example on a file server or anywhere else on the network where other teachers also have access.

5.2 Create a test using the Test Wizard

Creating a test using the Test Wizard consists in going through these steps:

1. In Tests View, right-click anywhere in the right pane and on the shortcut menu click New Test.

2. Give the test a name and possibly a description to more easily identify it later on.

   Once you have typed a name for the test, the Test Wizard will guide you through the test creation and ensure that you define all the necessary options.

3. Create the test questions.

   Tips

   • Before you start creating questions, you might want to review the sample test that comes with Netop School. The sample test includes examples of all question types.

   • If you would rather create the test without being led through the necessary steps, click the Advanced button to skip the wizard.

   On the Test Questions wizard page, click the Add button to add a question to the test. For details about each question type, see Question types.

   Use the Scoring button to modify the default even scoring for each question. For details about scoring and weight for each question, see Test scoring and Question weight exceptions.

4. Define the visual layout of the test as it will be presented to the students.

5. Define test and results properties like a time limit on the test, whether the test should start automatically on student computers, and whether you want to see test results on an ongoing basis throughout the test.

5.3 Create a test using the Test Designer

Creating a test using the Test Designer consists in going through these steps:

1. In Tests View, right-click anywhere in the right pane and on the shortcut menu click New Test.

2. Give the test a name and possibly a description to more easily identify it later on.
Creating tests

Now the **Test Designer** opens.

3. Click the **Add Question** button to create the test questions. For details about each question type, see **Question types**.

**Tips**

- Before you start creating questions, you might want to review the sample test that comes with Netop School. The sample test includes examples of all question types.
- If you would rather create the test using a wizard that leads you through the necessary steps, click the **Wizard** button.

4. Click the **Style** button to define the visual layout of the test as it will be presented to the students.

5. Click the **Options** button to define test and results properties like a time limit on the test, whether the test should start automatically on student computers, and whether you want to see test results on an ongoing basis throughout the test.

6. Click the **Scoring** button to review and possibly change the question weights. For details about scoring and weight for each question, see **Test scoring** and **Question weight exceptions**.

**5.4 Question types**

When you create a test, whether you use the Test Wizard or the Test Designer, you can choose between a number of different question types; some are purely text-based while others have a mixture of text and graphics.

**Drop-down List**

In this question type, the student reads a text where words are missing. The student must select the correct answer for each of the missing words from a drop-down list of true and false answers.

**How to create the question type:**

1. In the **Text** text box, write your complete text as it should appear to the student.

2. In your text, select each word that should be part of the test and click the **Select** button beneath the text box.

   The selected word is shown in bold face in the text.

3. Beneath the **False Answers** list, click the **Add** button and type a false answer.

Both the words written in bold in the text, the correct answers, and the word in the **False Answers** list will appear in the drop-down list that the student sees instead of the correct words.

**Tip**

If the text is very long and the number of marked words and false answers becomes too many, split the text into more questions.

See these questions in the sample test for an illustration of the drop-down list question type:
Creating tests

- L'imparfait - French
- Weather and climate - definitions

Essay

In this question type, the student writes an essay or any other type of free text.

**How to create the question type:**
- Type the question or the instructions in the **Question/Instructions** text box.

The student will have a basic, Notepad-like editor to write his text in.

See this question in the sample test for an illustration of the essay question type:
- **Incomplete fairytale**

**Note**

This is the only question type that does not offer auto-complete as a definite answer cannot be defined for a free text question. Even with no auto-complete, a significant advantage of this question type is that results are auto-collected and response time potentially controlled by a time limit.

Label Image

In this question type, the student labels an image, that is, places labels in the correct locations on a picture or other illustration.

**How to create the question type:**
1. Click the **Add Image** button to add the image file that the student will label.
2. Click the **Add Label** button and type a label text.
3. Move the label to the appropriate position on the image.
4. Repeat steps 2 and 3 until you have added the label texts you want and placed them in the correct locations on the image.

The student will see a list of labels and is supposed to move each label to the correct location.

See this question in the sample test for an illustration of the label image question type:
- **Name the Planets**

Match Image

In this question type, the student matches images with the corresponding texts.

**How to create the question type:**
1. Click the **Add** button and select an image file.
   - The image is added in the **Answers** list.
2. Type a text that matches the image.

The student will see the images and is supposed to move each image next to the appropriate text.

See this question in the sample test for an illustration of the match image question type:

- **Dinosaurs**

**Match Text**

In this question type, the student fills in blanks in a text with words from a list.

**How to create the question type:**

1. Type the entire text in the **Text** text box.
2. Select a word in the text that you want to have appear blank in the text and click the **Select** button.
   
The text is added to the **Word list** list.
3. Repeat step 2 for each word that you want to have appear blank in the text.

The student will see the text as you typed it but with blanks for the words that you selected and is supposed to place each word in the appropriate position in the text.

See this question in the sample test for an illustration of the match text question type:

- **Shakespeare - quote**

**Multiple Choice**

In this question type, the student selects one or more answers for each question from a list.

**How to create the question type:**

1. Type the question or the instructions in the **Question/Instructions** text box.
2. Click the **Add** button and type an answer.
3. Repeat step 2 for each answer you want the student to be able to choose from.
4. Select the correct answer in the list.

Optionally select the **Multiple correct answers** and **Random order** check boxes.

The student will see the question with a list of possible answers and must select one or more. If **Random order** was selected, the possible answers are presented in a different sequence for each student.

See these questions in the sample test for an illustration of the multiple choice list question type:

- **The capital of France**
Creating tests

- The Elements - science

Ordering

In this question type, the student puts items in a list in the correct sequence.

**How to create the question type:**
1. Type the question or the instructions in the Question/Instructions text box.
2. Click the Add button and type an item.
3. Repeat step 2 for as many items as you want the student to order.

The student will see a numbered list with no items and a list of items and is supposed to move each item next to the appropriate number.

See this question in the sample test for an illustration of the ordering question type:

- Days of the week

Question and Answer

In this question type, the student must type an answer to a question. The student’s answer must completely match the answer that the teacher is looking for.

**How to create the question type:**
1. Type the question or the instructions in the Question/Instructions text box.
2. Click the Add button and type the answer.
   - Depending on the question, there might be several answers. Make sure to include all correct answers.

The student will see the question and type the answer in a basic, Notepad-like editor. The answers have to be 100% identical to the teacher’s result list, otherwise the answer will not be scored as correct. Note, though, there is no distinction of case so that "A Streetcar Named Desire" is perceived as identical to "a streetcar named desire".

**Tip**
If five answers are possible, you can state in the question that the student has to list at least three.

See this question in the sample test for an illustration of the question and answer question type:

- Tennessee Williams

Text Completion

In this question type, the student must type the missing words in a text with blanks for some of the words.

**How to create the question type:**
1. Type the entire text in the Text text box.
Creating tests

2. Select a word in the text that you want to have appear blank in the text and click the Select button.

   The text is added to the Word list list.

3. Repeat step 2 for each word that you want to have appear blank in the text.

   The student will see the text as you typed it but with blanks for the words that you selected and is supposed to type the missing words in the text when dictated by the teacher.

   See this question in the sample test for an illustration of the text completion question type:
   * Complete the text - dictation

5.5 Tips about creating test questions

Below are some tips that you might find useful when you are creating questions for a test.

A sample test

Netop School includes a test called "SampleTest" with samples of all question types.

To view the sample questions:
1. In Tests View, double-click SampleTest.
2. In the TestDesigner, double-click the question type you want to study.

   Use the Preview button to see how each of the sample questions will appear to the student.

Preview a question

When you are creating a question you can preview the question as it will appear to the student.

Each of the different dialog boxes to create a question includes a Preview button.

Time limit

When you create a question, you can set a time limit on each question. When the student has spent the allotted time on the question, the test automatically advances to the next question.

Each of the different dialog boxes to create a question includes a Time limit button.

Additional resources for a question

Some questions may require background information or illustrations. When you create a question you can choose to attach a information to the question. The file will be available to the student along with the question.

Each of the different dialog boxes to create a question includes a Resources button.
5.6 Tips about test settings

Below are some tips that you might find useful when you are specifying how a test should behave during startup and while students are answering questions.

Allow students to skip a question and go back
You can choose to let students skip a question in a test and return to the question later.

- Select Unrestricted in the Test Type list.

The Test Type list is available on the Test Options wizard page, and from the Options button in the Test Designer.

Specify a time limit for a test
You can choose to set an upper time limit for the test duration. When the limit is reached the test closes automatically on the student computers.

- Type a number of minutes in the Time Limit field.

The Time Limit field is available on the Test Options wizard page, and from the Options button in the Test Designer.

Start a test automatically when all student computers are logged on
You can choose to have a test start automatically when all student computers are logged on.

- Select the Autostart Test check box.

The Autostart Test check box is available on the Test Options wizard page, and from the Options button in the Test Designer.

Prompt for student name before test start
You can choose to have students identify themselves before the test starts.

- Select the Prompt for name before test begins check box.

The Prompt for name before test begins check box is available on the Test Options wizard page, and from the Options button in the Test Designer.

Follow the test progress
You can choose to follow the progress of each student, for example which question the student is currently working on and whether the student skipped a question.

- Select the Perform real-time reporting during test check box.

The Perform real-time reporting during test check box is available on the Test Options wizard page, and from the Options button in the Test Designer.

Giving students their score
Scores are automatically set and summarized as the test advances. You can choose whether you want Netop School to send the final test results to each student, and if
Creating tests

you choose to send the result you can also choose when to send it:

- A student has submitted a test and the test is received by the Teacher module (Test received).
- The test ends, either because the time limit is reached or because you choose to end it (Test terminated).

The Send test result when check box and the when-options are available on the Test Options wizard page, and from the Options button in the Test Designer.

5.7 Folders

Three folders are available for tests and surveys:

**Public Tests**

This is the default folder where all tests and surveys are created and saved.

The folder is public and this means that all teachers who have access to Netop School can see all tests, surveys and results.

**Tip**

If more than one teacher computer is used and teachers should have access to the public tests regardless of the teacher computer they are using, it might be a good idea to place the public folder on a shared network drive. Shared public folders for tests and surveys are defined from the Options tab:

- On the Options tab, in the Advanced group, click Sharing.

**Private Tests**

If you want to save tests, surveys and results privately so that others cannot see them, use the Private Tests folder.

If you switch to this folder before creating a test or a survey, the test or survey is saved here. The Private Tests folder is located under your Windows profile. Depending on the operating system you use, this could for example be:

C:\Documents and Settings\<user name>\Application Data\Danware Data\Netop School\Teacher\Tests

**Tip**

If you want to move a test from the public folder to the private folder, use cut and paste from the public to the private folder:

1. Right-click the test you want to move and then click Cut.
2. Switch to the folder that you want to move the test to.
3. Right-click and then click Paste.

**Private Folder**

This folder does not exist from the outset. The option allows you to browse to any folder or create a new one where you want it.

This folder is private like the Private Tests folder; the difference is that you name it and place it where you want.
5.8 Create a survey

Creating a survey consists in going through these steps:
1. In Tests View, click the Survey tab.
2. Right-click anywhere in the right pane and on the shortcut menu click New Survey.
3. Give the survey a name and click OK.
4. Type a topic, a question and click the Add button to add answers to the survey.
   Click the Preview button to see how the survey will appear to the students.

5.9 Advanced test topics

5.9.1 Test scoring

When test questions are created, they are equally scored. This means that if you create 10 questions in a test, each questions has a 10% weight so that, for example, 5 questions answered correctly gives a score of 50%.

The Test Designer offers a graphic visualization of the question weights, including the option to change the scoring.
- In the Test Designer click the Scoring button to open the graphics view. Initially you can use the SampleTest as an example.

Each column represents a question; the darker gray column is the currently selected question. Select a question to see its weight and pass properties.

Question weight

Change the Question Weight either by dragging the border to the left or to the right, or by entering a percentage in the field to the right. The total test score always is 100%.

When the weight of a specific question has been changed its value is locked and changing another question’s weight will not affect it. The remaining questions are equalized within the 100%.

Note

The weight may change under certain conditions; for details refer to Question weight exceptions.

Right-click anywhere in the grid area to open a shortcut menu to reset any changes you made.
Creating tests

Question passed

Change the **Question Passed** either by dragging the border *up or down*, or by entering a percentage in the field to the right.

Questions that are not answered or incorrectly answered will not affect the final score. They are counted as "0".

Altering the passed question threshold allows you to create a ‘two out of three’ scoring. The passing criterion is only linked to one question. Click **Show Answers Grid** on the shortcut menu to toggle to answers view instead of questions view.

Award negative

**Award Negative** is a global setting for the entire test: Select the **Award Negative** check box to have all questions which are answered incorrectly count as negative instead of "0".

This means that if a question weight is for example 10%, then an incorrect answer causes the final score to be lowered with 10%. This makes it more difficult to pass a test.

5.9.2 Question weight exceptions

A question weight which was set individually (with an explicit value) will be changed automatically under certain conditions:

1. When an additional question is added, all existing non-explicit questions transfer weight to the new question.

   **Example:**
   
   You have 11 questions of which four have 20% weight - the remaining seven split the remainder (each have 2,9%).
   
   Add a new question. The four still are 20%, but the eight questions each have 2,5% weight.

2. If the last change makes the total larger than 100% - the weights loose their proportional relationship. Right-click the table and select **Reset All**.

   **Example:**
   
   Continue the example from above and change the weight of one of the 2,5%-questions to 20%.
   
   Because you are violating the 100% rule (five 20% fixed-weight questions and seven 2,5% equals 117,5%), all questions have to transfer weight. Your violation causes the constraints to break.
   
   Now you have five 12,6% fixed-weight questions and seven 5,3% auto-weight questions.
6 Set up student computer permissions

6.1 Create a policy

A policy in Netop School defines which programs student computers can use and which Internet sites student computers are allowed to visit.

A policy can be completely permissive and allow students to use all programs installed on their computers and to access all Internet sites. This is the default Netop School policy called Allow All. Typically, though, some Internet sites are irrelevant in an educational context. Restricted access in relation to such sites is set up by specifying site names or parts of site names that students should not be able to access.

At the other end of the scale is the Deny All policy type which is completely restrictive and as the name implies prevents access to using any programs and to accessing any Internet sites.

Follow these steps to create a policy that restricts access to specified Internet sites:

1. On the Options tab, in the Control group, click Policy.

2. In the Policy Options dialog box, click the New button and type a policy name on the New Policy tab.

   A temporary name based on the current date is suggested; if you are not sure about the exact contents of the policy, you can give it an appropriate name when you have defined access options.

3. In the Edit Policy dialog box, click the Internet tab.

4. On the Internet tab, right-click anywhere in the Internet Addresses list and click New.

5. Specify an internet address and click OK to add the address to the user defined Internet Addresses list.

   The address can be a precise address, like for example www.amazon.com, or just letters in an address, like for example "buy". Note that the less precise an address is, the more sites are likely to get blocked.

6. Move the address from the Internet Addresses list to the Except list.

When applied to student computers, the student computers can access all Internet sites with the exception of the ones listed on the Except list.

If a student computer tries to access a site where access has been blocked, a "Web access denied" message displays instead of the intended site.

6.2 Define which programs students should be allowed to use

Typically students are allowed and expected to use the programs installed on the student computers.

However, in some contexts like for example a test situation, it might be useful to have a policy that prevents students from using one or more of the installed programs.

1. On the Options tab, in the Control group, click Policy.

2. In the Policy Options dialog box, select an existing policy and click Edit - or click the New button and type a policy name.
Set up student computer permissions

3. In the **Edit Policy** dialog box, click the **Application** tab.
   
   Note that **Allow All** is the default; this means that students can use all the installed programs.

4. Open one of the three default folders, **Desktop**, **Start Menu** or **Program Files**, by double-clicking the folder icon.

5. From the expanded list, move the relevant program to the **Except** list by clicking the **Move** button.

Use the **Favorites** folder to add programs that do not already appear in one of the default folders:

1. Select the Favorites folder and then click the **New** button.
2. In the **Open** dialog box, browse to the program you want to add, select it and click **Open**.

---

**Tip**

Even programs that are not available on the teacher computer can be disallowed, provided that you know the name of the executable (.exe) file: Follow the steps above but in the **Open** dialog box, type the name of the executable, for example `firefox.exe`.

You can also block opening of specific documents: In the **Open** dialog box, in the **Files of type** field, select **All Files (*.*)** to be able to select other file types than .exe, or simply type the name of the document in the **File name** field.

---

6.3 Define Internet access for student computers

Student computers in some settings may be used primarily for information research on the Internet and here the most important tool might be search engines like Google and the hits the engines generate.

In other settings student computers may be used primarily for specific student assignments with predefined supporting materials in the form of notes, books or handouts, electronic or hard copy.

The need for Internet access in the two scenarios is very different. In the first scenario, it might make sense to have an **Allow All** policy with a black list of undesirable sites where access is blocked. In the second scenario, it would likely make more sense to have a **Deny All** policy with a white list of the few sites that would be needed for the specific assignments.

1. On the **Options** tab, in the **Control** group, click **Policy**.
2. In the **Policy Options** dialog box, select an existing policy and click **Edit** - or click the **New** button and type a policy name.
3. In the **Edit Policy** dialog box, click the **Internet** tab.
   
   Note that **Allow All** is the default; this means that student computers can access all Internet sites.
4. In the **Internet Addresses** list, select the **Favorites** folder icon and click the **New** button.
5. Type an Internet address and click **OK**.
6. The address is now added under the **Favorites** folder icon.
Set up student computer permissions

7. From the list of Internet addresses, move the relevant address to the **Except** list by clicking the **Move** button.

If **Allow All** is left as the basic policy, then the addresses in the **Except** list are the ones that student computers are not allowed to access. This would match the first scenario outline above.

If **Deny All** is selected instead, then the addresses in the **Except** list are the only ones that student computers have access to. This would match the second scenario where students have limited need for Internet access.

**Note**

To be able to block access to specific Internet sites, the port used for Internet communication must be on the list of ports that Netop School scans. If the standard port for Internet access - port 80 - is used, it is already on the list. However, if your computer environment does not use standard ports, you should add the port used to the list: On the **Options** tab, in the **Control** group, click **Policy** and review the **Ports to scan** list.

### 6.4 Advanced alternatives to defining access

If you want to block access to using for example chat or mail programs, one way to do this is to add the programs that you know that the students are using to the list on the **Applications** tab in the **Edit Policy** dialog box. One challenge with taking this approach is that students can add programs so that the list needs updating at regular intervals.

As an alternative to blocking specific programs, you can choose instead to block the communication ports used by these types of programs. For example, to block chat programs you could block use of the ports used for chat; ports 1336, 1735, 2031, 2330, 2451, 2703, 3032 would block access to most chat programs.

To block access to the Internet, you could block port 80.

Blocking the use of specific ports is set up from the **Edit Policy** dialog box:

1. On the **Options** tab, in the **Control** group, click **Policy**.
2. Create a new policy or select and existing one and click **Edit**.
3. In the **Edit Policy** dialog box, click the **Port** tab.
4. Select one of the ports already listed or right-click to create a new port and then drag the port to the **Except** list.

**Tip**

For details about port numbers and assignments, see the list of ports [http://www.iana.org/assignments/port-numbers](http://www.iana.org/assignments/port-numbers) on the Internet Assigned Numbers Authority (IANA) site ([www.iana.org](http://www.iana.org)).

### 6.5 Deny access temporarily

In **Activity View** the lower pane lists all active programs and currently accessed Internet sites.

If several student computers use the same program, only one icon will be listed but the number of students appears beside it as well as the names of the users.

Denying access to a program, in **Active Applications and Sites** or on the individual student computer, acts as a temporary policy.
Set up student computer permissions

- Right-click the program you want to prevent student computers from using and on the shortcut menu click **Deny**.

The student computers will get a message saying that access to the program has been blocked and the program disappears from the student computers' user interface.

To bring the program back on the student computers:
- On the **Favorites** tab, in the **Policy** group, click **Allow All**.

**Note**
Applying a temporary policy works only for the duration of the class. Once the student computers exit the class, the policy no longer works and the temporary policy will not be saved.

We recommend that you use **Hide** if student computers are supposed to use the program at a later stage in the lesson.

### 6.6 Apply and reset a policy

When you have defined a policy from the **Options** tab, you can apply it from the **Control** tab:

1. Select the student computers that should have a new policy applied.

2. On the **Control** tab, in the **Policy** group, click **My Policies** and then click the name of one of the polices you have created.

The policy is now applied on the selected student computers.

**Tip**
When a new policy is applied on a student computer, the student is informed of the change in a notification message. This default behavior can be changed from the **Policy** options dialog box: On the **Options** tab, in the **Control** group, click **Policy**.

When a policy is applied that denies access to a program that is already open on the student computer, the program is hidden but remains in the same state. This means that when the policy is removed, the student user will see the program again and any unsaved changes to open documents will be intact.

When a student tries to open a program where access is denied in a policy, the program will simply fail to start.

**Note**
When the student leaves a class and rejoins the same class, either by actively using the **Rejoin Class** command or by an involuntary disconnect and reconnect, the policy that existed on the student computer before the disconnect is automatically reapplied to the student computer when rejoining.

**Reset a policy**

- On the **Control** tab, in the **Policy** group, click **Reset Policy**.

This will remove existing policies and apply the policy that has been defined as startup policy (A startup policy is defined here: On the Tools tab, in the Startup group, click **Class**).
Preparing from home

7 Preparing from home

7.1 Export module and data

Netop School allows you to copy the Teacher module and any data you have created, like for example lesson plans or tests, to a removable media like a USB drive or a rewritable DVD. This means that you can work with the Teacher module on any computer and bring your finished work back to the Teacher module.

Follow these steps to copy both the Teacher module and data to a USB drive:

1. Connect the USB drive to the computer where the Teacher module is installed.
2. Start the Teacher module.
3. On the Manage tab, in the Teacher group, click Export Module and Data.
4. Create a folder on the USB drive.
   The file transfer commences immediately.
5. When the file transfer ends, remove the USB drive.

Now you can bring the USB drive and prepare tests and lesson plans on any Windows computer.

Note
The approximate size of Netop Teacher is 95 megabyte (MB).

7.2 Work on exported module and data

To be able to work on the Teacher module and data that you have previously exported and saved on a USB drive, follow these steps:

1. Connect the USB drive drive the computer where you want to work.
2. In Windows Explorer, browse to the folder that you created when you exported module and data and then double-click the Teacher shortcut.

The Teacher module now starts as it normally does in a Teacher-Student environment and you can work with the module as you normally would. Leave the USB drive connected to the computer until you have finished working in the Teacher module and have closed the module.

7.3 Import data to module

When you have been working at another computer on the exported module, the data that you have added in the form of lesson plans or tests can be imported into the Teacher module in your normal working environment.

1. Connect the USB drive that you used to work on to the Teacher computer where you want to import your work.
2. Start the Teacher module.
3. On the Manage tab, in the Teacher group, click Import Data.
4. In the Data Import dialog box, select the types of data you want to import and click OK.
For example, if you have been adding or modifying lesson plans, select the **Lesson Plans** check box.

5. Browse to the Teacher folder on your USB drive and click **OK**.

The types of data you selected are now imported into the Teacher module.
8 Customizing your workspace

8.1 Personalize

Use the Personalize Ribbon dialog box to customize the Teacher tabs to match your teaching methods and preferences.

The personalize options let you completely define both the layout of tabs and groups as well as which commands should be available on each tab and within each group. You can:

- Create new tabs and groups.
- Remove tabs and groups.
- Rename tabs and groups.
- Hide tabs and groups.
- Reorganize tabs and groups.
- Reorganize individual commands within tabs and groups.
- Rename individual commands.
- Define whether normal buttons, small buttons or text should used for individual commands.

All settings are saved as part of the teacher profile. This means that users can have their own personalized teacher workspace.

Tip

- When you begin your personalization of tabs, groups and commands, your work is made easier if you start by choosing the built-in profile that is closest to the way you like tabs and groups organized. The three profiles Standard, Compact and Text can be selected from the Options tab, in the Profiles group. If you select the Standard profile, any changes you make are made in that profile only and saved at part of your teacher profile. The other two profiles remain unchanged.

While you work on personalizing the Ribbon, you can continuously see the effects of the selections you make as the Ribbon is updated with each change you make.

The default Teacher module layout can always be restored by clicking the Reset to default button.

In addition to layout, text and icons, you can also use the Personalize Ribbon dialog box to customize Teacher access keys. This enables you to access any command using the keyboard.

See Also

Rename, reorganize or hide tabs
Create a new tab
Customize individual commands
Customize display options
Access any command using the keyboard
8.2 Rename, reorganize or hide tabs

Use the buttons in the **Ribbon Control Bar** section to add, remove, rename and hide tabs and groups on the Ribbon.

You can also right-click the list of tabs and groups to open a shortcut menu with add, remove, rename and hide commands.

**Rename a tab or a group**

1. In the list of tabs and groups, select the item you want to give another name and then click the **Rename** button.
2. Type an appropriate name and press the Enter key.

**Reorganize tabs or groups**

- In the list of tabs and groups, select the item you want to move and then click the **Up** or **Down** button depending on where you want to move the item.

When you move a tab, you move the tab itself as well as the groups it contains. When you move a group, the tab remains where it is and only the group is moved. This is convenient if you want to move a whole group of commands from one tab to another.

**Hide a tab or a group**

- In the list of tabs and groups, select the item you want to hide and then click the **Hide** button.

When you hide a tab, you hide the tab itself as well as the groups it contains. When you hide a group, the tab and its other groups remain visible.

In the list of tabs and groups, a hidden item displays in gray.

8.3 Create a new tab

1. On the **Options** tab, click **Personalize**.
2. Under **Tabs and groups**, click the **Add** button and then click **Tab**.
   - A new tab is created.
3. Type a name for the new tab.
   - Note that the tab will not be visible on the Ribbon until a group and one or more commands have been added.
4. Click the **Add** button and then click **Group**.
   - A new group is created.
5. Type a name for the new group.
6. Select the new group and in the list of commands select a command you want to include in the new group and then click the **Add command** button.

The new tab with one group and one command is now visible on the Ribbon. Repeat steps 4 through 6 to add more groups and commands.
Customizing your workspace

Tip
To add, remove, rename or hide, you can also right-click the list of tabs and groups.

8.4 Customize individual commands

Using the commands in the Profiles and Themes groups on the Options tab, you can define the general layout and color scheme for the Teacher module. And using the Personalize command in the Advanced group you can achieve the next level of customization by creating new tabs or reorganizing the existing ones.

The Personalize command can also be used for the third level of customization: to define layout and naming for individual commands. Each command can be represented by a large button and a corresponding large icon, a small button and a corresponding small icon, or just by a button with text.

For either of the three representations, you can choose the standard command name - or you can rename the command if you find another name more suitable.

Change layout for an individual command

1. On the Options tab, in the Advanced group, click Personalize.
2. In the Personalize Ribbon dialog box, under Tabs and groups, select the command you want to change and under Button type, select the type of button for the command.
   - Leave the Text check box selected to have the name of the command shown along with an icon.
   - Select the User-defined option if you want to rename the command.

8.5 Access any command using the keyboard

The Teacher Ribbon has predefined access keys that allow you to use the keyboard to get to almost any command by using only two or three keystrokes.

An access key is an alphanumeric key that, when combined with the Alt key, activates a control. Access keys are shown in the user interface and are not intended to be memorized.

To view the predefined access keys in the Teacher Ribbon, press the Alt key.

Use an access key

1. Press the Alt key.
   The KeyTips are displayed over each tab, like in the illustration above.
2. Press the character shown in the KeyTip over the tab that you want to use.
   For example, if you press "1" to select the Favorites tab, a KeyTip is displayed for each of the commands on the Favorites tab.
3. Press the character shown in the KeyTip over the command that you want to use.

**Tip**
To cancel the action that you are taking and hide the KeyTips, press the Alt key.

**Customize the access keys**

By default, the predefined access keys are all numbers: the tabs are numbered from left to right and within each tab, the commands are also numbered from left to right. These key definitions can be changed to match your preferences. The access keys are defined from the Personalize Ribbon dialog box:

- On the Options tab, in the Personalize group, click Personalize.

To change an access key for a tab or a command, select the tab or command in the Ribbon layout list and type the character you want to use in the Keyboard shortcut field. One or two characters can be used.

For example, if you wanted to use the first letter of each tab name to open the tab, you would do the following:

1. Select the Favorites tab in the Ribbon layout list and type the first letter of the tab name in the Keyboard shortcut field.
   
   This would be "F" in the English version of Netop School but would likely be different in other languages.

2. Select the Teach tab in the Ribbon layout list and type the first letter of the tab name in the Keyboard shortcut field.

3. Repeat the above step for each tab.

   When you get to a tab where the first letter is identical to a previously used key, an error message is displayed. For example, in the English version of Netop School, "Teach" and "Tools" begin with the same letter so one of these tabs has to have a different key assigned. This could for example be "T" for "Teach" and "TO" for "Tools".

Customizing or defining new access keys may also be relevant if you choose to change the layout of the Ribbon, for example by adding tabs of your own or by renaming the existing ones. When you create a new tab or command, an access is is automatically assigned.

**8.6 Restore default settings**

When you personalize the Teacher module, for example by creating new tabs, by reorganizing the existing tabs or by hiding commands, you change one of the built-in profiles and save the changes as part of your teacher profile.

- If you want to undo all changes you have made to a profile, click the Reset to default button in the Personalize Ribbon dialog box.

This will undo any changes you made to the current profile, included any tab pages or groups you have added as well as re-defined access keys.
8.7 Customize display options

A number of options are available to allow you to customize the Teacher module look.

If several teachers are using the same computer each can have their individual settings. To have individual looks, users must be logged on using teacher profiles; for more information about teacher profiles, see Teacher Options.

Classes can have individual backgrounds only if they are named uniquely. If the teachers 'Jones' and 'Smith' both have a class named 'History', Netop School will not be able to differentiate.

- **Change the number of tab pages and button size**
  - On the Options tab, in the Profiles group, click Standard, Compact or Text.
  
  These are the built-in profiles that can be used as they are, or form the basis for further personalization. See Personalize for information about personalization options.

- **Change color scheme**
  - On the Options tab, in the Themes group, click one of the available color schemes, or click Custom to define your own.

- **Change the views buttons sequence**
  - Move each button to the position within the pane where you want to place it.

  The button positions are saved as part of the teacher profile.

- **Change the bitmap in the top left corner**
  1. Right-click the bitmap to open the Set Bitmap dialog box.
  2. Click Custom and browse for a bitmap file.
  
     Sample bitmaps are available in this folder c:\Program Files\Danware Data\TEACHER\media folder.
  3. Select the bitmap and click OK.

     If several teachers are using the same computer, the corner bitmap will follow the teacher.

     **Note:** Only files in bitmap format (.bmp) can be used. The size is W80 x H60.

- **Change the background bitmap in Classroom and Thumbnails Views**
  1. Right-click the background bitmap in either of the two views and then click Set background bitmap.
  2. In the Set Background Bitmap dialog box, select the Enable background bitmap and, optionally, the Tile background bitmap check boxes and browse for a bitmap file.

     Sample bitmaps are available in this folder c:\Program Files\Danware Data\TEACHER\media folder.
  3. Select the bitmap and click OK.

     **Note:** Only files in bitmap format (.bmp) can be used.
These windows are Teacher Profile independent. This means that if the background image is changed, this is how the Teacher module interface will appear to the next teacher.

**Change the thumbnail bitmap position, size and update interval**

- In **Thumbnails View**, right-click the background bitmap, on the shortcut menu point to **Thumbnail** and then click **Customize**.

If you only want to adjust the size, a number of standard size choices are available from the shortcut menu.

The shortcut menu also lets you define sorting method. **Floating** is the default sorting method; with this method large size bitmaps may overlap each other and may have to be moved manually. If you do not want to adjust manually, select another sorting method.

**Change the Groups display**

- In one of the views that use groups, right-click the **Groups** area and on the shortcut menu click the appropriate command.

The selected groups display are for the current view only and does not impact other views with groups.
9 Daily student tasks

9.1 Join a class

Typically the student computer automatically joins a predefined class when the Student module is started. This means that you are automatically in the right class when the computer starts and you can wait for the teacher to take action.

The student computer can also be set up to allow you to select a class from a list of available classes. If the student computer is on a different network from the teacher computer, you can connect to the teacher computer by specifying an IP address.

You can also wait for the teacher to invite you to join a specific class. In this situation all you have to do is to accept the invitation.

Tip

The Student module will typically be set up to start when Windows starts, to automatically join a class and to be minimized on startup. To set these options in the Student module:

- On the Options tab, in the Startup group, click General.

9.2 Communicate with the teacher

You can communicate with your teacher and with the other students but the communication has to be initiated by the teacher. The only way a student can begin communication is by clicking the help request icon.

The teacher can

- Send you a text message which you can save and print but which you cannot respond to.

- Start a chat session that you can respond to. You can personalize by changing font. The chat window stays open until the teacher chooses to end the chat session.

- Start an audio or audio-video chat; this requires that both computers have the appropriate hardware installed. The audio chat allows you to talk to the teacher - one-to-one in an Open Discussion - like on the phone. If more students are involved in the audio chat session, the teacher will use a Moderated Discussion and you may talk to any of the participating fellow students when the moderator, the teacher, activates your microphone. The audio-video chat window stays open until the teacher chooses to end the session.

The teacher will typically use one of these communication methods in response to a help request from you.

See Also

Request help from the teacher

9.3 Take a test

Tests are started by the teacher and open by themselves. The only thing you have to do to begin answering is to enter your name.

When you have entered your name and clicked OK you are ready to take the test.
There are two types of tests:

**Unrestricted**
This test type allows you to skip a question and return to it at a later stage. It is also possible to return to an already answered question to change your answer.

If you wish to submit your test before the time limit, click **Submit Test**.
Click **Cover Page** to reread the test instructions.

**Restricted**
In this test type you have to answer the questions sequentially and you cannot go back to a question you have previously answered.

When you submit the test you will receive an auto-generated message with test result listing your score and whether you have passed the test.

It is up to you whether you answer all questions or submit without answering all.

---

**Note**
Please note that each question can have a time limit. If the time limit is exceeded on a question the test will proceed to the next question.

The whole test can also have a time limit. If the time limit is exceeded the test will terminate automatically.

---

### 9.4 Assist the teacher

The teacher can choose to set up a workgroup in the class and appoint a student to be an assistant teacher.

When a student computer temporarily takes over as a teacher computer, the student computer automatically has the same user interface and access to the same features as a teacher normally has.

### 9.5 Request help from the teacher

- To request help from the teacher, click the life belt icon

If the Student module runs in hidden mode, the life belt icon is located in the notification area; double-click it to open the **Help Request** dialog box.

If the Student module runs in normal mode, the **Request help** button is located on the Student module toolbar. Alternatively, click **Request help** on the **Action** menu.

When you have typed and sent your question, the life belt icon changes slightly; click the icon to cancel your help request if you have resolved your issue and no longer need assistance.

### 9.6 End remote control

If you are in a remote control session you can end the session if you do not want to be controlled:

- On the **Action** menu, click **End Session**.
Daily student tasks

Note
This is possible only if the teacher computer has allowed student computers to retain control of their own keyboard and mouse during a remote control session. The teacher may have chosen to lock both.

9.7 Play a recording

Typically a recording is a file that the teacher creates and distributes to selected student computers for the students to view when it fits into the individual's lessons or preparation work. When the teacher distributes a recording, it automatically appears on the student computers' Recordings tab in a default folder called Recording.

To play a recording from the Recordings tab:

- Right-click the relevant file and then click Playback recording.

Tip
If the Recordings list becomes very long you can improve the overview by organizing the files in subfolders.

9.8 Unhide the Student module

If a student computer has been set up to run in Stealth mode and you need to change this, start a remote control session.

1. Select the student computer in question.
2. On the Control tab, in the Supervision group, click Remote Control.
3. On the remote controlled student computer, find the executable file: C:\Program Files\Danware Data\Netop School\STUDENT\Showhost.exe
4. Double-click Showhost.exe and the Student module will be restored to normal mode.
5. On the student computer, run the Student Setup Wizard and make the necessary changes.

9.9 What the teacher can do on a student computer

Below is an overview of what the teacher can do on a student computer.

Demonstrate what is on the teacher computer's display

The teacher can start a demonstration session and show what takes place on the teacher computer; in such situations your display will be identical to the teacher's display.

While the teacher is demonstrating, your keyboard and mouse are locked and you cannot use them.

The teacher can choose to give student computers some control from the demonstrate toolbox.

Use the demonstrate toolbox to:
Daily student tasks

- Request microphone during chat. Note that the button is only active during an audio chat session.
- Request help from the teacher.
- Request control of the keyboard and mouse.

**Remote control your computer**

The teacher can choose to remote control your computer as if sitting in front of it. This could for example be useful if you are missing a file or your computer does not work correctly.

Depending on the teacher's settings, your keyboard and mouse may be locked by the teacher when your computer is remote controlled but the teacher can also choose to allow both you to use keyboard and mouse.

**Supervise what you are working on**

The teacher can supervise what you are working on, without you necessarily knowing about it. The teacher can see what each student is working on and which programs they are using.

**Lock your screen, keyboard and mouse**

The teacher can lock your computer and show a picture or some text on all student computer screens. The student computers remain locked until the teacher unlocks them.

**Start a chat**

The teacher can start a chat session with you. The chat can be pure text or - provided that the necessary equipment is available and has been enabled - include sound and picture.

A chat is always started by the teacher but you can of course respond.

The chat ends when the teacher ends it.

**Close down or re-start your computer**

The teacher can log you off, restart your computer or close down your computer.

**Distribute and collect materials**

The teacher can distribute files to your computer, and collect files that you have placed on your computer.

This is can be used for exchange of assignments and papers.

**Limit or block Internet access**

The teacher can block internet access completely, or block access to specific sites. When access has been blocked, you will see a blocking page in your browser.
Daily student tasks

Tip
Click the policy icon in the notification area to see the contents of the current policy.

Limit or block computer programs
The teacher can block use of some or all applications on your computer.
If use of a program has been blocked, you will be unable to start it up. If the program is already running when a new policy is enforced, the program will be closed down.

Tip
Click the policy icon in the notification area to see the contents of the current policy.

Draw or write on the student computer screen
When the teacher is remote controlling a student computer, the teacher can use the Marker Utility to highlight areas on the student computer.

Tip
You can prevent the teacher from doing some of these things on your computer; see Protection options for details.
10 Other Teacher tools

10.1 Netop Screen Image

Netop Screen Image is a tool for taking screen shots.

To start Netop Screen Image:

- On Windows Start menu, point to All Programs, Netop School, Tools and then click Screen Image.

Use the tool to create screen shots of the active window, the active window without a title bar, the entire screen or an area of the screen.

**Take a screen shot**

1. Set up the tool according to your preferences.
   - On the Capture tab, select the key that you want to use to start the capture.
   - On the Image tab, select the area you want to capture.
   - On the Save As tab, select naming, file type and location.
   - On the Preferences tab, select whether the Screen Image icon should be included in the screen shot and whether a notification should open when a screen shot has been taken.

   These settings are saved and can be used the next time you want to do a screen shot.

2. Click OK to close the tool dialog and minimize it.

3. Press the key you chose to use as capture key to do the screen shot.

10.2 Netop Screen Video

Netop Screen Video is a tool for recording the actions you take and the commands you click.

To start Netop Screen Video:

- On Windows Start menu, point to All Programs, Netop School, Tools and then click Screen Video.

Use the tool to create a video within an area of the screen of or the entire screen.

**Do a screen video**

1. Set up the tool according to your preferences.
   - On the Region menu, select the area you want to capture. **Tip:** Typically Full Screen is selected.

   - On the Options menu, select recording options and define settings. **Tip:** It is frequently a good idea to hide the program when recording starts, and to define keyboard shortcut keys to start and stop the recording.

   These settings are saved and can be used the next time you want to do a screen video.

2. Click Record to start recording.
Click the appropriate commands to demonstrate the task you want to record.

3. Stop recording by pressing the shortcut key you defined. Alternatively you can right-click the Netop Screen Video icon in the notification area and click Stop on the shortcut menu.

## Overview of the Options menu

<table>
<thead>
<tr>
<th>Video Options</th>
<th>Change the encoder to be used for the video recording. For the configurable encoders, click Configure to set for example compression.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Move the Quality slider to the right to increase quality. Note that a higher quality video file will be larger.</td>
</tr>
<tr>
<td></td>
<td>You can let Netop Screen Video automatically adjust frame rates: Leave the Auto Adjust check box selected.</td>
</tr>
<tr>
<td></td>
<td>Or you can clear the Auto Adjust check box and set the options yourself:</td>
</tr>
<tr>
<td>Max frame rate</td>
<td>left end represents recording 200 frames/second and Max frame rate right end represents recording 1 frame/minute. When you move the slider, the Set Key Frames Every, Capture Frames Every and Playback Rate fields are automatically adjusted:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Recording frame rate</th>
<th>Set Key Frames Every</th>
<th>Capture Frame Every</th>
<th>Playback Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>200 - 1 frames/second</td>
<td>Second</td>
<td>0.005 - 1 second</td>
<td>Recording frame rate</td>
</tr>
<tr>
<td>60 - 1 frames/minute</td>
<td>20 frames</td>
<td>1 - 60 seconds</td>
<td>20 frames/second</td>
</tr>
</tbody>
</table>

**Notes**
- Playback will synchronize at each key frame.
- A large number of frames will make a large file.

**Cursor Options** Define whether the mouse pointer should be included in the recording, and to define the pointer appearance.

**Audio Options** Define options for recording sound as well as video.

**Autopan Speed** Setting autopan speed is relevant when Enable Autopan has been selected (command above in the same menu). Automatic panning means that the recording region center is automatically moved towards the mouse pointer position while recording. When Enable Autopan is not selected, the recording region center does not move.

**Autopan Speed** defines how fast the recording region center is moved.

**Recording Thread Priority** means that a priority is set for use of computer resources for Netop Screen Video as compared to other program running at the same time.
### General guideline

If the video recording does not play smoothly, computer resources may be too slim and it might help to raise the **Recording Thread Priority**.

<table>
<thead>
<tr>
<th><strong>Keyboard Shortcuts</strong></th>
<th>Define keyboard keys to control the recording.</th>
</tr>
</thead>
</table>

---

---
11 Dialog box help information

11.1 Teacher options

11.1.1 Demonstrate options

Use the Demonstrate options to define what happens on the students' computers when you click one of the demonstrate alternatives on the Teach tab.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Demoed Student</td>
<td>The teacher can temporarily use one of the student's computers to demonstrate to the other students. While doing so, it might be useful to be able to prevent the student from using mouse and keyboard. Click Session Properties to change other default properties on the student's computer.</td>
</tr>
<tr>
<td>On Teacher during Student Demo</td>
<td>When using a student's computer to demonstrate to the other student, it might be useful to see the selected student's screen in full screen mode on the teacher's computer as well.</td>
</tr>
<tr>
<td>On Receiving Students</td>
<td>These options are available to define what happens on the computers of the students who see the demonstration of one of their fellow student's screen:</td>
</tr>
<tr>
<td></td>
<td><strong>Show demo in full screen at Startup</strong></td>
</tr>
<tr>
<td></td>
<td>The demonstration fills the entire screen.</td>
</tr>
<tr>
<td></td>
<td><strong>Demo in bitmap mode</strong></td>
</tr>
<tr>
<td></td>
<td>Transfer the Teacher screen image to Students receiving a desktop demonstration as a bitmap image.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong></td>
</tr>
<tr>
<td></td>
<td>The default command mode screen image transfer is fast. With certain hardware and application combinations, command mode cannot transfer certain screen image details. If important screen image details are missing on Students when demonstrating, using bitmap mode transfer should remedy the situation. However, bitmap mode transfer is slower than command mode transfer.</td>
</tr>
<tr>
<td></td>
<td><strong>Launch Toolbox</strong></td>
</tr>
<tr>
<td></td>
<td>Select this if you will allow the Students to interrupt to asks questions during a demonstration.</td>
</tr>
</tbody>
</table>
11.1.2 Run options

Use the Run options to add programs that you want to be able to activate from within the Teacher module; the programs are added to the Run My Programs menu in the Run group on the Teach tab.

The Run program list displays the list of programs that have already been added.

Add a program

1. Click the Add button.

2. In the Run dialog box, type a descriptive text in the Description text box. This text will appear on the menu.

3. Under File name, make sure that the Local file name option has been selected and then click the Browse button to locate the program .exe file.

   When the program file is added, the Global file name where the absolute path has been replaced with environment variables is automatically added. This is especially helpful if your computers are running different Windows platforms.

   Example of a Local file name and the corresponding Global file name:

   C:\Program Files\Adobe\Acrobat 6.0\Reader\AcroRd32.exe
   %ProgramFiles%\Adobe\Acrobat 6.0\Reader\AcroRd32.exe

   Tip  Once you have added a program under Local file name and the Global file name has been added automatically, select the Global file name option button so that you do not have to consider which operating system version or operating system language student computers are using.

4. Under Run, click Normal, Maximized or Minimized to define how the program should start when opened from Run My Programs (on the Teach tab, in the Run group).

   If the selected program needs to be started using command line switches, use the Command line switches text box to type those. This could for example be starting Internet Explorer with a specific address or for Adobe Acrobat Reader, the name of the document to read.

Tip

When you later start a program that you have added to the Run My Programs menu, you can choose how to run the program:

- Run the program on selected student computers.
  
  If a student computer cannot find the program file, the Information column in the Details View shows "File not found."

- Run the program on the teacher computer.

- Run the program in demonstration mode: run the program on the teacher computer while running an Entire Screen demonstrate session on the selected student computers.

The run mode is flexible in that you can choose a different one each time you run a program.
11.1.3 Attention options

Use the Attention options to define what displays on the student computers when you click one of the attention alternatives to lock keyboard and mouse on student computers.

When student computers are locked you can choose to show:

**A picture**  
A default picture is installed with Netop School but you can also choose a different picture.

To choose a different picture file:

- Click the **Browse** button under the **Image File** heading and locate the file you want to use.

If you add several files, each file is added to a submenu so that when you later use the **Image File** command on the **Control** tab, you can choose which file to use.

**Note**  
The file must be in the same location on all computers. Use **File Manager** or **Distribute** on the **Manage** tab to distribute a file to all computers.

Click **Centered** or **Stretched** to define how the picture should be displayed. When **Centered** is used and the picture is smaller than the screen, you might want to set a background color: Click the **Background color** button.

**A short text**  
Type the short message to be displayed on all student computers, for example:

"Please see the list of assignments for tomorrow on the board."

**The contents of a text file**  
If you have a longer message, or if you want to use the same message several times, you can create a text file with the information you want to display. This could for example be the curriculum or the list of upcoming exam dates and times.

If you add several files, each file is added to a submenu so that when you later use the **Text File** command on the **Control** tab, you can choose which file to use.

These display options are available for presentation of the text file:

- Display the text centered in the screen.
- Define a background color for the screen.
- Define a font properties like font face, font style and color for the text message.

**A Web page**  
Choose a specific Web site that you to display.

The Web page displays without navigation and menu bar.
11.1.4 Policy options

Use the Policy options dialog box create, update, rename or delete policies.

**Note**
The three default policies, Deny All, Allow All and Deny Internet, cannot be modified or deleted.

Select the Show Notification on Students check box to show a policy icon in the notification area on student computers.

Netop School can block Internet sites on all browsers on operating systems from Win2000 and forwards. Not only will communication be blocked through Internet browsers, browsing from within programs will also be blocked.

When a policy has been defined, it can be applied from the Control tab: on the Control tab, in the Policy group, click My Policies and select one of the policies in the list.

**Ports to scan**

The Ports to Scan list includes the ports that Netop School scans and is capable of blocking access to when a policy related to Internet access is defined.

**Note**
If the port your computer environment uses for Internet access is not on the list, you should add it by clicking the Edit button.

This means that if you want to create a policy that allows Internet access generally but blocks access to specific sites that are unrelated to teaching contexts, the port used for Internet access in your computer environment needs to be in the Ports to scan list. Typically port 80 is used for Internet access but if a different port has been defined for your computer network, you must add that specific port.

If your computer environment uses a proxy server for Internet access, make sure that the proxy port is included in the list.
### 11.1.5 Supervision options

Use the **Supervision** options to define settings for the commands available on the **Control** tab in the **Supervision** group.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Control</td>
<td>Define settings for <strong>Remote control</strong> of students’ computers. Selecting <strong>Remote Control in Bitmap mode</strong> means that Netop School bypasses Windows Graphics Device Interface (GDI) which normally handles transfer of screen information. Continuous bitmap snapshots are transferred instead. Performance is slower but everything comes across. Use this option if the student screen display that you see is incomplete, typically with black squares. This can happen if the student computer is running graphics intensive programs like games that bypass the Windows GDI.</td>
</tr>
<tr>
<td>Observe Students</td>
<td>Define settings for <strong>Observe Students</strong>. Set the interval between observing each student in the <strong>Observe interval between</strong> field. Select <strong>Observe in Bitmap mode</strong> if you want to monitor student computers without interrupting student users. When the <strong>Observe in Bitmap mode</strong> check box has been cleared, the student computer’s screen will flicker briefly when the teacher computer starts the observe session.</td>
</tr>
</tbody>
</table>

**Details about optimization**

The default is that the **Observe in Bitmap mode** check box is cleared. This means that the student computer’s screen will be optimized for data transfer before the transfer takes place and this optimization will cause the screen to flicker slightly.

Optimization options are set on the **Desktop** tab in the **Session Properties** dialog box.

Full optimization means that various display options, like for example wall paper and screen saver, are temporarily disabled on the student computer before the transfer. Disabling these option make the transfer faster but is also likely to disturb the student.

Click the **Session Properties** button to set up how students’ screens are displayed on the teacher's desktop.

### 11.1.6 Session properties

Use the **Session properties** to define how the students’ screens are displayed on the teacher’s desktop and to optimize teacher/student remote control sessions. The four tabs are used as follows:

**Display**

Define how a student’s screen displays on the teacher screen.
**Keyboard/Mouse**  Define how keyboard and mouse should work.

**Compression**  Adjust the compression to allow for limited network bandwidth.

**Desktop**  Optimize screen transfer to fit your environment’s capabilities.

### Display tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student window fit</td>
<td><strong>Fit window to student screen</strong>  Adjust the size of the Student screen to the size of the Teacher screen.</td>
</tr>
<tr>
<td></td>
<td><strong>Fit student screen to window</strong>  Scale and place the Student screen inside the Teacher window.</td>
</tr>
<tr>
<td></td>
<td><strong>Do not fit</strong>                  Transfer the Student screen to the Teacher screen, unaltered.</td>
</tr>
<tr>
<td>DOS Box Font</td>
<td>Use the system default font, or click the Select font button to change.</td>
</tr>
</tbody>
</table>

### Keyboard/Mouse tab
## Dialog box help information

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Keyboard</strong></td>
<td></td>
</tr>
<tr>
<td>Remote Keyboard</td>
<td>Allow the teacher to get and share the full control of the student computer.</td>
</tr>
<tr>
<td>Local keyboard</td>
<td>Allow the teacher remote control the Student, without transferring special keystrokes to the Student.</td>
</tr>
<tr>
<td>No keyboard control</td>
<td>Allow the teacher to monitor the student computer.</td>
</tr>
<tr>
<td>Select <strong>Use Teacher keyboard layout</strong> if the Teacher and Student keyboards are different.</td>
<td></td>
</tr>
<tr>
<td>Select <strong>Don’t transfer Student Num Lock, Scroll Lock, Insert and Caps Lock</strong> to suppress these keys on the Teacher computer.</td>
<td></td>
</tr>
<tr>
<td><strong>Mouse</strong></td>
<td></td>
</tr>
<tr>
<td>Remote mouse</td>
<td>Allow the teacher to get and share the full control of the student computer.</td>
</tr>
<tr>
<td>Local mouse</td>
<td>Hide the teacher’s mouse movements on the Student screen.</td>
</tr>
<tr>
<td>No mouse control</td>
<td>Allow the teacher to monitor the student computer.</td>
</tr>
<tr>
<td>Select <strong>Display Student mouse movements</strong> to be able to see the student’s mouse movements on the Teacher screen.</td>
<td></td>
</tr>
<tr>
<td>Remote Control Hot keys assignment</td>
<td>Select a key combination to zoom the controlled student computer.</td>
</tr>
<tr>
<td></td>
<td>The default selection is Alt+Z and we recommend that you do not change this.</td>
</tr>
</tbody>
</table>

### Compression tab

Netop School can compress Student screen image data to speed up transmission across slow communication lines. However, data compression in itself takes time so compression may impact CPU performance.
### Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
</table>
| Compression level   | Automatic: Let the Teacher module determine compression level. In most cases, this provides the fastest communication.  
No compression: Select this option if your bandwidth is high (cable, LAN).  
Low: Select this option if your bandwidth is medium high (DSL).  
High: Select this option if your bandwidth is low (modem). |
| Demo in bitmap mode | Select Disable accelerated bitmap transfer in the rare situations when transfer causes communication problems. |

#### Desktop tab

Advanced student computer desktop features slow down screen image transfer and are typically unimportant for the Teacher. Therefore, the Student screen image per default is transferred without advanced desktop features.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
</table>
| Optimize screen transfer       | Always: Transfer without advanced desktop features.  
Only when high compression: Transfer without advanced desktop features only with high compression.  
Never: Transfer with advanced desktop features. |
| Optimization parameters       | Full optimization: Transfer without the desktop features listed under Custom options.  
Custom optimization: Enable the Custom options to select which advanced desktop features shall be transferred. |

11.1.7 Class options

For teachers: Use the Class options to add classes when more than one is needed, and to define various global class options.

For students: Use the Class options to select how to select which class to join on startup.

#### Teacher Class options
### Dialog box help information

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class name</td>
<td>The class name list displays the existing classes. Select the relevant class in the list. However, note that changing the class will disconnect any connected student computers. Use the <strong>Add</strong>, <strong>Copy</strong> and <strong>Delete</strong> buttons to manage classes. Note that <strong>Delete</strong> removes the selected class without prior warning.</td>
</tr>
<tr>
<td>Use Class Server</td>
<td>Select this option if the Class Server module (Class Server is an advanced module that is part of the NetOp Class Management package. For additional information, see <a href="http://www.netop.com/netop-389.htm">http://www.netop.com/netop-389.htm</a> has been installed and is used on the network to facilitate connections. Click <strong>Setup</strong> to provide Class Server information.</td>
</tr>
<tr>
<td>Always Select Class at Startup</td>
<td>When the Teacher module is started, always present the dialog box that lists the classes available.</td>
</tr>
<tr>
<td>Modify when Students join late</td>
<td>If students join a class after it has been started, the teacher is notified.</td>
</tr>
<tr>
<td>Auto join</td>
<td>Options for letting students join a class:</td>
</tr>
<tr>
<td></td>
<td><strong>No - Never</strong>: Students will not be able to join an ongoing session.</td>
</tr>
<tr>
<td></td>
<td><strong>Yes - Automatic</strong>: Students automatically join an ongoing session.</td>
</tr>
<tr>
<td></td>
<td><strong>Prompt before join</strong>: Ask the teacher's permission when a student connects during a session.</td>
</tr>
<tr>
<td>Startup Policy</td>
<td>Select a policy from the list; the default selection is <strong>None</strong>. Policies that have been added from the <strong>Policy</strong> teacher button are also available.</td>
</tr>
</tbody>
</table>

### Student Class options
## Option  
**Description**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect to class</td>
<td>The name of the class the student computer automatically joins on startup. The class names are defined by the teacher computer. This is the default setting.</td>
</tr>
<tr>
<td>Browse for Classes</td>
<td>Look for classes that a teacher has already started. When this option has been selected, you can choose which class to join from a list of classes.</td>
</tr>
<tr>
<td>Be available for any Class</td>
<td>The student computer does not join any class but is available for a teacher computer's invitation to join a class.</td>
</tr>
<tr>
<td>Select Class</td>
<td>Select among available classes. When the <strong>Class Name</strong> option is selected, you can select a class from a list of class names. When the <strong>IP address or DNS name</strong> option is selected, you can connect to a class running a Teacher module on another IP subnet without knowing the class name.</td>
</tr>
<tr>
<td>Use Class Server</td>
<td>Select this option if the <strong>Class Server</strong> module (Class Server is an advanced module that is part of the NetOp Class Management package. For additional information, see <a href="http://www.netop.com/netop-389.htm">http://www.netop.com/netop-389.htm</a> has been installed and is is used on the network to facilitate connections. Click <strong>Setup</strong> to provide Class Server information.</td>
</tr>
</tbody>
</table>

### See Also

- [Join a class](#)

### 11.1.8 Class Server Setup

Students using a computer running Netop Student and teachers using a computer running Netop Teacher can connect to Netop Class Server to get their current or upcoming lesson from the class database.

#### Teacher Class Server setup

### Note

All student computers must be set up to use Class Server as well.
### Dialog box help information

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class Server</td>
<td>The name of the Class Server. On startup, the teacher computer browses for and connects to the Class Server specified. Note that the name is case sensitive.</td>
</tr>
<tr>
<td>IP Address or DNS name</td>
<td>If the Class Server is on an IP-subnet different from the teacher computer, the Class Server IP address or DNS name must be entered for the teacher computer to be able to reach it.</td>
</tr>
<tr>
<td>Extend Lesson</td>
<td>By default the Teacher module stops automatically according to the defined schedule when using Class Server. When this option is selected, the teacher is notified five minutes before a class is scheduled to end, and will be able to extend the lesson beyond schedule.</td>
</tr>
<tr>
<td>Identify Teacher by</td>
<td>Select the name to be used to identify the teacher computer to the Class Server.</td>
</tr>
</tbody>
</table>

### Student Class Server Setup

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class Server</td>
<td>The name of the Class Server. On startup, the student computer browses for and connects to the Class Server specified. Note that the name is case sensitive.</td>
</tr>
<tr>
<td>IP Address or DNS name</td>
<td>If the Class Server is on an IP-subnet different from the student computer, the Class Server IP address or DNS name must be entered for the Student to be able to reach it.</td>
</tr>
<tr>
<td>Rejoin on Disconnect from Teacher</td>
<td>The student computer can be disconnected from the teacher computer either automatically at the end of a class or unintentionally. Select this option to ensure that the student computer automatically rejoins the class in case of an unintentional disconnect.</td>
</tr>
<tr>
<td>Show Class list</td>
<td>Select this check box to view a list of available classes in scenarios when unintentionally disconnected and pick one to connect to. If the check box is cleared, the computer automatically joins the first upcoming class for that student. This is defined in the Class Manager.</td>
</tr>
<tr>
<td>Identify Student by</td>
<td>Select the name to be used to identify the student computer to the Class Server.</td>
</tr>
</tbody>
</table>
11.1.9 General options

Use the General options to define global settings for the Teacher or the Student module.

Teacher General options
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>Select the <strong>Save new students between classes</strong> check box to keep student computers that have connected to a class as members of the class. Select the <strong>Get available students</strong> check box to have the Teacher module automatically identify and include available students in a class.</td>
</tr>
</tbody>
</table>
| Student display name           | Choose what name should be shown in the **Student Display Name** column in the teacher's details view. When **Student login name** is selected, the Teacher module basically lets the student decide what should be shown in the **Student Display name** column. Selecting one of the other two options, **Windows login name** or **Computer name**, means that the Teacher module decides what should be displayed. **Tips**  
  - The student login name is specified in the Student module: on the **Tools** menu, click **Options** and then double-click **Student Login**.  
  - If the selected student display name is not available for some reason, the student computer will be identified by a name given in square brackets.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                      |
| Display custom columns in detailed view | The details view is customizable in the sense that one or two columns can be added. Type a column heading in the **Title** box and a Windows environment variable name in the **Column value** box, for example "Computer name" and "%COMPUTERNAME%" Other relevant Windows environment variables: %USERNAME%, %DATE%, %TIME%                                                                                                                                                                                                                                                                                                                                                                                                                                                                       |
| Connection password            | Use a connection password to ensure that only students and teachers using the same **Connection Password** can connect. The student **Connection Password** is set from the **General** options dialog box on the Student module.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                         |
### Student General options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Startup</strong></td>
<td>Define how the student module should start up and appear on startup. Frequently selection options are: <strong>Load Student at Windows startup</strong> and <strong>Minimize Student at program startup</strong>.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>When a student computer starts up in stealth mode, you have no access to the Student module functionality at all. Before you select the Stealth mode (hide Student when started) check box, we recommend that you learn how to unhide the student module again; see <a href="#">Unhide the Student module</a>.</td>
</tr>
<tr>
<td><strong>Supervision Session</strong></td>
<td>Define how the Student module appears when the teacher computer is observing or remote controlling the student computer.</td>
</tr>
<tr>
<td><strong>Connection Password</strong></td>
<td>If a password is entered here the Teacher has to use the same password in order to connect.</td>
</tr>
</tbody>
</table>

### 11.1.10 Audio-Video Chat options

Use the **Audio-Video Chat** options to define microphone sensitivity and line hold when a communication session is initiated **Audio-Video Chat** on the **Teach** tab.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Silence level</strong></td>
<td>Adjust the silence level (dB) to your way of talking (how loud). The farther to the left, the more quiet you can talk to open the line.</td>
</tr>
<tr>
<td><strong>Line hold</strong></td>
<td>Adjust the line hold duration (seconds) to optimize the bandwidth usage. The microphone switches off whenever the time runs out and the conversation is too silent.</td>
</tr>
</tbody>
</table>

Click **Check Sound System** to perform a sound verification test.

### 11.1.11 Advanced audio settings

Use the **Advanced audio settings** to change the preferred playback and record devices and to change audio compression settings.

If more devices are available on your computer, they are listed in the drop-down lists.

Depending on the network type (LAN or Internet) adjust the sound quality by selecting 8
or 16 bit and the frequency span (Hz).

Arrange the **Audio Compression** using the **Up** and **Down** buttons. The list gives the sequence that the Teacher module uses when trying to connect to student computers.

**Notes**

- 16 bit, uncompressed normally produces the best sound.
- The compression codec has to be present on both Teacher and Student in order to work.

### 11.1.12 Connection options

Use the **Connection** options to modify the default connection settings. These settings are usually changed by the system administrator only and are sketchily described below. For details about communication options, refer to the Advanced User’s Guide which is available from the Netop Downloads site.

The connection options dialog boxes are very similar in the Teacher and the Student modules.

> **Teacher Connection options**
### Dialog box help information

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max packet size</td>
<td>Select <strong>Automatic</strong> if you want Netop School to adjust the packet size. Select <strong>Specify</strong> to define the packet size. <strong>Tip:</strong> If you experience problems with the sound during an audio chat or video conference, try to reduce the packet size. A large packet size might work well on a local network but not on the Internet.</td>
</tr>
<tr>
<td>Communication profile</td>
<td>Select the communication profile. Default selection is <strong>TCP/IP</strong>.</td>
</tr>
<tr>
<td>Netop Name Server</td>
<td>Enter the <strong>Name Space ID</strong>. The default is &quot;PUBLIC&quot; If the Teacher module connects to student computers using NetOp Name Management, the <strong>Name Space ID</strong> field in the Teacher and Student modules must be identical.</td>
</tr>
</tbody>
</table>
| Student Polling         | Select the **Polling** checkbox if you want the Teacher module to send Student modules a network packet to verify that they are still connected. **Tip**  
  - There is no communication between the Teacher module and connected student computers between commands issues from the Teacher module. This means that a lost connection can potentially go undetected for a while. Polling student computers at intervals will detect and restore a lost connection if at all possible. If you frequently experience lost connections to student computers, select the **Polling** check box and specify an interval. |

**Note**
The Teacher module must be restarted for changes to connection options to apply.

**Student Connection options**
Dialog box help information

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication profile</td>
<td>Select the communication profile. Default selection is <strong>TCP/IP</strong>.</td>
</tr>
<tr>
<td>Netop Name Server</td>
<td>Enter the <strong>Name Space ID</strong>. The default is &quot;PUBLIC&quot; If the Teacher module connects to student computers using Netop Name Management, the <strong>Name Space ID</strong> field in the Teacher and Student modules must be identical.</td>
</tr>
<tr>
<td>Subnet Assistant</td>
<td>If several student computers are located on a subnet which is remote from the Teacher computer, you can improve the communication by making one of the student computers a <strong>Subnet Assistant</strong>. This means that communication will be routed from the teacher computer to the Assistant Subnet student computer and from there on to the other student computers. To do this you need to specify the teacher computer IP address.</td>
</tr>
</tbody>
</table>

**Note**
You must click **Rejoin Class** for changes to connection options to apply.

11.1.13 Personalize options

Use the **Personalize Ribbon** dialog box to customize the Teacher tabs to match your teaching methods and preferences.

The personalize options let you completely define both the layout of tabs and groups as well as which commands should be available on each tab and within each group. You can:

- Create new tabs and groups.
- Remove tabs and groups.
- Rename tabs and groups.
- Hide tabs and groups.
- Reorganize tabs and groups.
- Reorganize individual commands within tabs and groups.
- Rename individual commands.
- Define whether normal buttons, small buttons or text should used for individual commands.

All settings are saved as part of the teacher profile. This means that users can have their own personalized teacher workspace.

**Tip**
- When you begin your personalization of tabs, groups and commands, your work is made easier if you start by choosing the built-in profile that is closest to the way you like
tabs and groups organized. The three profiles Standard, Compact and Text can be selected from the Options tab, in the Profiles group. If you select the Standard profile, any changes you make are made in that profile only and saved at part of your teacher profile. The other two profiles remain unchanged.

While you work on personalizing the Ribbon, you can continuously see the effects of the selections you make as the Ribbon is updated with each change you make.

The default Teacher module layout can always be restored by clicking the Reset to default button.

In addition to layout, text and icons, you can also use the Personalize Ribbon dialog box to customize Teacher access keys. This enables you to access any command using the keyboard.

See Also
- Rename, reorganize or hide tabs
- Create a new tab
- Customize individual commands
- Customize display options
- Access any command using the keyboard

### 11.1.14 Protection options

Use the Protection options to select which commands on the Options tab should be protected with a password. Any user trying to access a protected option will be prompted to enter a password.

Note that a password must be defined for the options to be protected: click the Change Protection Password button to define a new password or change an existing one.

### 11.1.15 Change Protection Password

Use the Change Protection Password dialog box to create a new password or change an existing one.

Remove password protection

Type the password in the Old password field and click OK.

### 11.1.16 Sharing options

Use the Sharing options to define a network drive where you can place the different types of files that can be created in the Teacher module and share with other teachers, regardless of their login. The files types that can be shared include lesson plans, policies and tests.

### 11.1.17 Teachers options

Use the Teachers options to define how teachers log on to and are recognized by the Netop School system.

The options are:
When teacher profiles are used, users log on with a user name and a password as defined as part of the profile. Another option is to have users log on using their Windows user name and password.

Select the Validate using Windows Security Management check box to have user use their Windows user name and password to log on to Netop School.

The process of adding users varies slightly for the two types of log on:

### Add a user when Teacher Profiles is used

1. In the Teachers options dialog box, select the Use Teacher Profiles check box.
   - Make sure that the Validate using Windows Security Management check box has been cleared.

2. Click the Add User button.

3. In the Teacher Profile dialog box, type a user name and a name in the corresponding text boxes.
   - **User name** is the user’s identification in the Netop School system while **Name** is the used to identify the user during chat and audio chat.

4. Click the Change Password button to add a password to the user profile and thus improve login security.
   - Type a password and re-type to confirm it. As with all passwords, the password is personal for the user; all users have their own password.

**Note**
If the password protection is used, a new teacher profile can only be added to the list if a teacher who is on the list opens it.

### Add a user when Teacher Profiles and Windows authentication are used

1. In the Teachers options dialog box, select the Use Teacher Profiles and the Validate using Windows Security Management check boxes.

2. Click the Add User button.

3. In the Teacher Profile dialog box, select domain and user, and type a name.
   - **Name** is the used to identify the user during chat and audio chat.
Tip
If the users to be added are all members of the same group, adding the group automatically adds all users. Each user will be able to log on to the Teacher module the same way they log on to Windows; they will be identified by their logon name in the Teacher module.

In addition to being able to specify user name and password for one or more user, defining teacher profiles has other advantages: user settings like folders, groups, tests, and bitmaps are automatically saved regularly.

### 11.1.18 Toolbar Commands options

Use the **Toolbar Commands** options to define which commands should be available from the various tabs.

By default, all commands are selected and appear on the tabs. The tabs can be customized and made shorter by clearing check boxes.

**Tip**
Use the **Personalize** command on the **Options** tab to rename and reorganize commands on tabs.

### 11.1.19 Web Update options

Use **Web Update** options to define settings for updating the Netop School software from the Web.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update server</td>
<td>The Internet address of the server where the software updates are located. This is relevant if, for example, one user downloads software updates to a local server and the other users updated from this server instead of using Internet time and bandwidth.</td>
</tr>
</tbody>
</table>

**HTTP proxy**

If the network where Netop School is installed uses a proxy server to access the Internet, click the **Detect** button to add the name of the proxy server.

**Tip**

Specifying an **HTTP proxy** is typically not required. Before specifying a value, click the **Update now** button to test the connection.

If the connection to the update server is OK, you do not need to specify an **HTTP proxy**.

If you get a message saying that there is no connection, click the **Detect** button to attempt to automatically identify the proxy server. When a proxy has been added, click **Update now** to test the connection.

If clicking the **Detect** button does not result in the name of a valid proxy server, you need to consult with your network or systems administrator.
Dialog box help information

administrator for valid proxy server information.

Updating the Netop School software can be done as a here-and-now action by clicking the **Update now** button, or the update can be scheduled to take place at regular intervals. Click **Schedule** to define the update intervals.

**Schedule tips**
- Checking for and installing updates generate an extra workload on the computer and in most setups it is not desirable to have all computers check for updates simultaneously during startup. If one of the automatic schedule options is selected and the update takes place **At loading**, we recommend that you specify a delay of 15-30 minutes in the **Delay** text box. This selection will randomize the intervals with which each student computer looks for new updates.
- If one of the automatic schedule options is selected and the update takes place either **Daily**, **Weekly** or **Monthly**, this combination does not impact the computer workload as much. We recommend that you select the **Randomize within the hour** check box to make the update less susceptible to heavy Web loads on specific times of the day.

11.2 Teacher dialog boxes

11.2.1 About NetOp School

Use the About box to verify the Netop School version and the serial number.

11.2.2 Audio-Video Chat

With **Audio-Video Chat** the teacher has a powerful communication tool which offers both sound and picture communication.

When the teacher has started the chat, the **Audio-Video chat** window automatically opens on the student computer and the communication can begin. The student can use sound and see the teacher if the teacher turns on video.

An **Audio-Video chat** can only be started by the teacher.

Audio-video chat offer two types of conferencing:

- **Open Discussion**: The teacher and one student can have a two-way discussion, like on the phone.
- **Moderated Discussion**: The teacher decides who speaks by selecting a student from the list.

  Once selected, the student can speak in the microphone until the teacher selects another student as speaker.

  In a moderated discussion, students can alert the teacher to the fact that they want to speak by clicking the **Request** button.

**Video Conferencing**

If the Teacher and the Students have webcams, video conferencing is possible. To enable this feature, click **Video**.
When video is enabled the webcams become visible in the Video section of the Audio-Video Chat window.

Two video streams are visible at a time:
- Top - your own
- Bottom - the current speaker

11.2.3 Chat

The chat session has to be initiated by the teacher since student computers can only request help.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dialog</td>
<td>The conversion that the chat parties have had so far.</td>
</tr>
<tr>
<td>Enter Chat contribution and</td>
<td>Type your chat message here.</td>
</tr>
<tr>
<td>click Send</td>
<td></td>
</tr>
<tr>
<td>Font</td>
<td>Change the font and font properties used in your chat session.</td>
</tr>
<tr>
<td>End chat</td>
<td>End the chat session. Only the teacher can end the chat.</td>
</tr>
<tr>
<td>Save</td>
<td>Save the chat conversation to a file. Its standard format is:</td>
</tr>
<tr>
<td></td>
<td>&lt;class name&gt; &lt;date&gt; &lt;time&gt;.rtf, for example My Class 30-04-2008 13-55-38.rtf</td>
</tr>
</tbody>
</table>

11.2.4 Collect File

Use the Collect File dialog box to specify the type of file to collect, for example "*.docx" if this is a writing assignment.

To specify a different folder, click Edit student location list.

See Also

Send and collect assignments

11.2.5 Collect files from Students

The Collect files from Students dialog box consists of three panes:
- Source: the files to be collected.
- Students: the student computers to collect files from.
- Destination: where the files should be moved to.

If files were previously distributed they will appear in the Source section of the Collect files from Students dialog box for easy collection.
### Dialog box help information

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify files</td>
<td>Open the Collect File dialog box to specify the file or type of files, for example *.doc, to be collected from student computers.</td>
</tr>
<tr>
<td>Include subfolders</td>
<td>Include any subfolders in the folder you selected to collects files from.</td>
</tr>
<tr>
<td>Delete on Student after collection</td>
<td>Delete the collected file from the student computers.</td>
</tr>
<tr>
<td>Wizard</td>
<td>Switch to the Collection Wizard.</td>
</tr>
<tr>
<td>Select destination</td>
<td>Specify an existing folder for the collected files. Use the Edit, New and Delete buttons to modify the pre-defined folder list.</td>
</tr>
<tr>
<td>Collect</td>
<td>Start the file collection.</td>
</tr>
</tbody>
</table>

**See Also**
[Send and collect assignments](#)

11.2.6 Combine Policies

When two or more policies have been defined, they can be applied to student computers as one combined policy.

This means that if you have defined two or three policies that you use regularly, you can apply them in combination rather than define a new policy that comprises all settings in the existing policies.

- Select two or more policies that you want to combine and then click Apply or OK to immediately apply the policy combination on the selected computers.

Note that as soon as you have selected the policies to combine, the lower part of the dialog box shows the result of the policies combination.

**See Also**
[Create a policy](#)

11.2.7 Customize Thumbnail

Use the Customize Thumbnail dialog box to specify

- Height and width properties for thumbnails.
- Space between thumbnail images.
- Number of colors used to display thumbnail images. Select fewer colors to lessen the system load.
- The frequency with which thumbnail images are updated. Select a high interval to lessen the system load.
Tips
- The thumbnail size you specify may cause the images to overlap. This can be prevented by setting spacing, or by setting a different sorting method than Floating.
- Generally small thumbnails, few colors and long update intervals will generate less network traffic.

See Also
Customize display options

11.2.8 Data Import
Use the Data Import dialog box when you have previously copied the Teacher module to an external media like a USB drive, worked in the module on another computer and want to bring your work back into the Teacher module you normally use.
- Select the types of data you have added or changed and click OK.

See Also
Export Teacher module and data
Work on exported Teacher module and data
Import data to Teacher module

11.2.9 Distribute files to Students
The Distribute files to Students dialog box consists of three panes:
- Source: the files to be distributed.
- Students: the student computers to distribute files to.
- Destination: where the files should be moved to.
Dialog box help information

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add folder</td>
<td>Specify individual files or folders to distribute.</td>
</tr>
<tr>
<td>Add files</td>
<td></td>
</tr>
<tr>
<td>Wizard</td>
<td>Switch to the Distribution Wizard.</td>
</tr>
<tr>
<td>Select destination</td>
<td>Specify an existing folder where the distributed files should be moved to. Use the Edit, New and Delete buttons to modify the pre-defined folder list.</td>
</tr>
<tr>
<td>Send files to same destination on Students</td>
<td>Distribute files to the selected student computers using the same path as the source file.</td>
</tr>
<tr>
<td>Use this destination when files are dropped and don't prompt with this dialog</td>
<td>Files can be moved directly from Windows Explorer to the selected students in the Teacher interface using a drag-and-drop operation. This opens the Distribute files to Students window to allow you to decide the destination for the files. If this is your favorite method and you always use the same destination, selecting the Use this destination when files are dropped and don't prompt with this dialog check box will distribute files directly to the selected destination and skip the window.</td>
</tr>
<tr>
<td>Distribute</td>
<td>Start the file distribution.</td>
</tr>
</tbody>
</table>

See Also
Send and collect assignments

11.2.10 Edit Policy

Use the Edit Policy dialog box to define the overall strategy with respect to use of programs installed on the students’ computers, and with respect to students’ access to Internet sites, and to define exceptions to the overall strategy.

The overall strategy is defined by clicking Allow All or Deny All.

The Except list contains the list of exceptions to the overall policy. For example, if the policy type is Allow All, the Except list on the Application tab displays the list of applications to which access is blocked.

Add an application to the Except list on the Application tab

1. In the Applications list, open one of the three default folders, Desktop, Start Menu or Programs Folder, by double-clicking the folder icon.

   Tip If a folder is empty, click the Rescan button to have the Teacher module add programs.

2. Select a program and move it to the Except list by clicking the Move button.

Use the Favorites folder to add programs that do not already appear in one of the three default folders: right-click Favorites and click New.
Add an Internet site to the Except list on the Internet tab

1. Click the **New** button.
2. Type an Internet address and click **OK**.
   
   The address is now added under the **Favorites** folder icon.
3. From the list of addresses, select one and move it to the **Except** list by clicking the **Move** button.

Add a port to the Except list on the Port tab

Use the **Port** tab to block access in specific ports. For example, to block instant messaging program you can choose to block the ports used for communicating instead of blocking specific programs. This could be a advantage if you are not familiar with the names of the programs that the students are using for instant messaging.

Like on the **Internet** tab, use the **New** button to add a new entry and the **Move** button to add it to the **Except** list.

See Also

- Create a policy
- Define which programs student should have access to
- Define Internet access for student computers
- Advanced alternatives to defining access

11.2.11 File Collection or File Distribution

The **File Collection** and **File Distribution** dialog boxes provide details about files that have been collected from student computers or distributed to student computers.

See Also

- Send and collect assignments

11.2.12 File Manager

Use the Netop File Manager to update, copy, move and synchronize files and folders between your computer and that of a student computer.

If necessary, the teacher computer can start several File Manager sessions with different student computers and run the sessions in parallel.
Dialog box help information

Overview of commands on the toolbar

Copy files from a directory on the teacher computer to a destination on a student computer, or vice versa.

**Result:** Files added to the destination.

Move files from a directory on the teacher computer to a destination on a student computer, or vice versa.

**Result:** Files deleted from source.

Synchronize files from a directory on the teacher computer to a destination on a student computer, or vice versa.

**Result:** The newest file replace the older one, and files missing on one side are added to the other side. The contents of source and destination folders become identical.

**Note**
Be very careful if you synchronize system files. This may cause your computers to malfunction.

By default the synchronization replaces older files with newer files. Click **Options** on the **Options** menu to set synchronize options.

Clone files from a directory on the teacher computer to a destination on a student computer, or vice versa.

**Result:** All files in the source folder are deleted before copying the selected files and folders. The contents of source and destination folders become identical.

Create a new folder.

Delete a file.

File or folder properties.

Select file. Use this to mass-select files with similar prefixes or suffixes.

Options to define how files are to be synchronized. See: **File Manager Options**.

Local allows you to perform file action on your own computer.

There are four different ways to display the files in the File Manager.
If no student computer has been selected, the teacher computer displays a dialog box to select one of the connected students from a list.

### 11.2.13 File Manager Options

Use the **Netop File Manager Options** dialog box to define parameters for file transactions handling.

**Overview of the tab pages:**

<table>
<thead>
<tr>
<th>Tab page</th>
<th>Use the tab page to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer</td>
<td>Define synchronize and transfer option.</td>
</tr>
<tr>
<td>Confirmation</td>
<td>Select the situations when a confirm dialog box should be displayed.</td>
</tr>
</tbody>
</table>
| Layout | • Define overall File Manager layout.  
        • Define hotkey layout.  
        • Select icon appearance. |

Click the **Default** button at any time to go back to the default settings.

### 11.2.14 Lesson Action

Use the **Lesson Action** dialog box to add tasks to a lesson plan. The lessons actions, or tasks, that can be added to a lesson plan are the tasks that you can also do from the **Teach**, **Control** and **Manage** tabs.

Note that an item to be added as a lesson action must exist before it can be added to a lesson plan. For example, if a test is to be one of the lesson actions, the test must be created in **Tests View** before it can be added as a lesson action.

1. Select action for the lesson item in the list.

   Some of the actions require additional setup information and when one of those is selected, the appropriate setup fields are displayed in the right part of the dialog box. Other actions require no configuration. For example, if the action is **Demonstrate Recording**, setup consists in selecting a recording file. If on the other hand the action is **Demonstrate Entire Screen**, no setup is required.

2. Select the student or the student group to receive this lesson item.

   **Tip** A lesson plan is typically created when you are offline, for example when you have exported module and data and are preparing for a class at home. To be able to select which students or groups that should be involved in the lesson plan, student information must be saved when the class is offline. This is automatically done if the option **Save new students between classes** is set. To verify that **Save new students between classes** has been selected:

   • On the **Options** tab, in the **Startup** group, click **General**.

3. Use the **Description** and the **Notes** text fields to type any information that could be helpful in identifying the lesson action and its purpose when you are later using it.

   Both texts are displayed in the lesson plan window.
<table>
<thead>
<tr>
<th>Action</th>
<th>Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demonstrate Entire Screen</td>
<td>No setup needed.</td>
</tr>
<tr>
<td>Demonstrate Selected Screen Area</td>
<td>Define size and position of area.</td>
</tr>
<tr>
<td>Demonstrate Media File</td>
<td>Browse the computer for a media file.</td>
</tr>
<tr>
<td>Demonstrate Media File on the Web</td>
<td>Type a Web page address and the media file name, for example: <a href="http://www.netop.com/media/movie.mpg">http://www.netop.com/media/movie.mpg</a></td>
</tr>
<tr>
<td>Demonstrate Specific Monitor</td>
<td>Select which monitor to use from a list.</td>
</tr>
<tr>
<td>Demonstrate Student Screen</td>
<td>Select which student screen to use from a list.</td>
</tr>
<tr>
<td>Demonstrate Recording</td>
<td>Select from previously created recordings.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> Recordings can be created from the <strong>Favorites</strong> tab and from the <strong>Teach</strong> tab.</td>
</tr>
<tr>
<td>Attention Default Image</td>
<td>No setup needed.</td>
</tr>
<tr>
<td>Attention Image File</td>
<td>Browse the computer for an image file.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> Use an image file on a shared drive that all student computers can also access.</td>
</tr>
<tr>
<td>Attention Text</td>
<td>Type the text to display.</td>
</tr>
<tr>
<td>Attention Text File</td>
<td>Browse the computer for a text file.</td>
</tr>
<tr>
<td>Attention Web</td>
<td>Type a Web page address.</td>
</tr>
<tr>
<td>Observe</td>
<td>No setup needed.</td>
</tr>
<tr>
<td>Remote Control</td>
<td>No setup needed.</td>
</tr>
<tr>
<td>Communicate Audio-Video Chat</td>
<td>No setup needed.</td>
</tr>
<tr>
<td>Communicate Chat</td>
<td>Type the topic of the chat.</td>
</tr>
<tr>
<td>Communicate Send Message</td>
<td>Browse the computer for a message file.</td>
</tr>
<tr>
<td>Workgroup</td>
<td>Type a work group name.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> One or more student groups must exist before a workgroup can be added as a lesson action. Student groups can be created from <strong>Class Setup View</strong>.</td>
</tr>
<tr>
<td>Run</td>
<td>Select the program to run from a previously defined list of programs.</td>
</tr>
</tbody>
</table>
**Log Off**
No setup needed.

**Restart**
No setup needed.

**Shut Down**
No setup needed.

**Distribute Files**
Select which files to distribute; you can select a single file or files from a specific folder.
Select where the files should go in a predefined list of destination folders; the destination is the same on all student computers.

**Tip**
The Select Destination list is based on the Select Destination list in the Distribute Files to Students dialog box. If you add to the list in that dialog box, the added destination is automatically available in the Lesson Action dialog box as well.

**Collect Files**
Type the name of the file to collect or specify a file type, for example *.docx.
Select where to collect files from on the student computers.
Select where the files should go on the teacher computer. As the files collected from student computers possibly share the same file name, a subfolder is created for each of the students. For example, if "Desktop" is selected as destination folder on the teacher computer:
C:\Documents and Settings\<teacher logon name>\Desktop\<student logon name>

**Tips**
- The Location list is based on the list defined in the Distribute Files to Students dialog box.
- The Select Destination list is based on the Destination list in the Collect Files from Students dialog box.

If you add to either of the lists in those dialog boxes, the added destinations are automatically available in the Lesson Action dialog box as well.

**File Manager**
No setup needed.
Dialog box help information

<table>
<thead>
<tr>
<th>Policy</th>
<th>Select from previously defined policies.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tip</td>
<td>Policies can be created from the Options tab.</td>
</tr>
<tr>
<td>Run Test</td>
<td>Select from previously defined tests.</td>
</tr>
<tr>
<td>Tip</td>
<td>Tests can be created from Tests View.</td>
</tr>
<tr>
<td>Run Survey</td>
<td>Select from previously defined surveys.</td>
</tr>
<tr>
<td>Tip</td>
<td>Surveys can be created from Tests View.</td>
</tr>
<tr>
<td>Stop</td>
<td>No setup needed.</td>
</tr>
</tbody>
</table>

See Also
Create and run a lesson plan

11.2.15 Location
Use the Location dialog box to create or modify a destination folder when collecting files from student computer, or when distributing files to student computers.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description of the folder as it will appear in the Select destination list in the Distribute files to Students or the Collect files from Students dialog box.</td>
</tr>
<tr>
<td>Path</td>
<td>Path and folder name. We recommend that you use environment variables rather than absolute an absolute path, for example: %USERPROFILE%\Test where %USERPROFILE% will translate into C:\Documents and Settings{username} (Windows XP) OR C:\Users{username} (Windows Vista)</td>
</tr>
</tbody>
</table>

See Also
Send and collect assignments

11.2.16 Net Addresses
Use the Net Addresses dialog box to view the computer IP address.

11.2.17 Netop Marker Utility
Use the Netop Marker Utility to draw and write on the student computer screen during a demonstration or a remote control session.

The tool can be used by both the teacher computer and the student computer. Note, though, that the student cannot initiate this feature. It only opens if the student is remote controlled and the teacher decides to start the Marker Utility.
The texts and lines created using the Netop Marker Utility 'float' over the desktop. If other applications are opened, texts and lines remain on top.

The Netop Marker Utility includes tools for drawing shapes like circles and rectangles and for writing text. In Netop Marker Utility, place the mouse pointer on a toolbar button for a description of the tool.

11.2.18 New Test or Survey

Use the New Test or the New Survey dialog box to type a name and a description for the test or the survey you have started to create.

The name is mandatory; the description can be used to more easily identify the test or survey at a later time and include, for example, information about which grade and which semester it was intended for.

11.2.19 Port Scan List

The Port Scan List dialog box lists the ports that Netop School scans and is capable of blocking access to when a policy related to Internet access is defined. If the port your computer environment uses for Internet access is not on the list, you should add it by clicking the Add button.

11.2.20 Run Program

Use the Run dialog box to locate a program that you want to run on selected student computers. Each program that you add to the list here becomes available on the Teach tab in the Run group on the Run My Programs submenu.

Note
The same version of the program needs to be installed on both teacher computer and on the selected student computers.

Add a program

1. Under File name, make sure that the Local file name option has been selected and then click the Browse button to locate the program .exe file.

   When the program file is added, the Global file name where the absolute path has been replaced with environment variables is automatically added. This is especially helpful if your computers are running different Windows platforms.

   Example of a Local file name and the corresponding Global file name:

   C:\Program Files\Adobe\Acrobat 6.0\Reader\AcroRd32.exe
   %ProgramFiles%\Adobe\Acrobat 6.0\Reader\AcroRd32.exe

   Tip Once you have added a program under Local file name and the Global file name has been added automatically, select the Global file name option button so that you do not have to consider which operating system version or operating system language student computers are using.

2. Under Run, click Normal, Maximized or Minimized to define how the program should start.

If the selected program needs to be started using command line switches, use the Command line switches text box to type those. This could for example be starting Internet Explorer with a specific address or for Adobe Acrobat Reader, the name of the
11.2.21 Student Information

All the students present in the Class Setup View carry with them information about the student’s login name, computer name, computer domain, Windows login name, Windows login domain, and wake on LAN MAC Address.

11.2.22 Student file location list

Use the Student file location list dialog box to add folders that you expect to collect files from on the student computers.

11.2.23 Style

Select a visual layout for all questions in the test. The style can later be changed.

If no style is select, the style called **Default** is automatically used.

See Also

Create a test using the Test Wizard
Create a test using the Test Designer

11.2.24 System Info

View technical information about the computer.

11.2.25 Test Designer

Use the Test Designer to access and customize all areas of a the test from a single screen: questions, layout, general test options, and scoring. The Test Designer also gives an overview of test questions and their properties, including the weight of each question.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Question</td>
<td>Add a new question to the test. For details about each question type, see Question types.</td>
</tr>
<tr>
<td>Remove Question</td>
<td>Delete the selected question with no further warning.</td>
</tr>
<tr>
<td>Style</td>
<td>Open the Style dialog box to select test layout for all questions.</td>
</tr>
<tr>
<td>Options</td>
<td>Open the Options dialog box to set or change general test settings.</td>
</tr>
<tr>
<td>Scoring</td>
<td>Open the score sheet to change the existing scoring for each question.</td>
</tr>
</tbody>
</table>

See Also

Create a test using the Test Wizard
Create a test using the Test Designer
### 11.2.26 Test options

Use **Test Options** to set global options for the test.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
<td>View and modify an existing the test description, or type one if it does exist. The description is visible in <strong>Tests View</strong> and can help you locate the right test in an extensive list.</td>
</tr>
<tr>
<td><strong>Author</strong></td>
<td>The name of the teacher who created the test.</td>
</tr>
<tr>
<td></td>
<td>The teacher name is defined from <strong>Tools &gt; Options &gt; Teachers</strong>.</td>
</tr>
<tr>
<td><strong>Created and Modified</strong></td>
<td>When the test was created and last modified. System information that cannot be changed.</td>
</tr>
<tr>
<td><strong>Test Type</strong></td>
<td><strong>Restricted</strong>: The student will have to follow the question sequence and cannot go back to answered questions.</td>
</tr>
<tr>
<td></td>
<td><strong>Unrestricted</strong>: The student may jump from question to question, regardless of sequence. Answers can be changed until the student submits the test or the test closes because the time limit is reached.</td>
</tr>
<tr>
<td><strong>Time Limit</strong></td>
<td>The maximum duration of the test.</td>
</tr>
<tr>
<td></td>
<td>When the time limit is reached the test closes and the results are sent to the teacher computer.</td>
</tr>
<tr>
<td><strong>Autostart Test</strong></td>
<td>The test starts automatically when all student computers are ready.</td>
</tr>
<tr>
<td></td>
<td>Clearing this check box means that the teacher must start the test by clicking the start button in the <strong>Test Monitor</strong> window.</td>
</tr>
<tr>
<td></td>
<td>For information about starting a test, see <strong>Run a test or a survey</strong>.</td>
</tr>
<tr>
<td><strong>Prompt for name before test begins</strong></td>
<td>Open a dialog box for the student to enter name before the test can start.</td>
</tr>
<tr>
<td><strong>Perform real-time reporting during test</strong></td>
<td>View student progress during the test.</td>
</tr>
<tr>
<td><strong>Send results when</strong></td>
<td>Distribute test results to student, and define when:</td>
</tr>
<tr>
<td></td>
<td><strong>Test received</strong>: A student has submitted a test and the test is received by the Teacher module.</td>
</tr>
<tr>
<td></td>
<td><strong>Test terminated</strong>: The test ends, either because the time limit is reached or because the teacher choose to end it.</td>
</tr>
</tbody>
</table>

**See Also**

Create a test using the Test Wizard
Create a test using the Test Designer
11.3 Student options

11.3.1 Help Request options

Select the Add Help Request icon to the tray check box to make access to asking to help from the teacher easily accessible from an icon in the notification area.

See Also
Request help from the teacher

11.3.2 Protection options

Use the Protection options to define the extent to which the teacher should be allowed to control and monitor the student computer.

Protection options are typically applied in an adult teaching environment where student users have full access to student settings and do not need or want close teacher control.

- Select the Enable Protection check box to make the detailed options available.

Use the Netop Guest Access section to allow a Netop Remote Control Guest to remotely control the student computer. The Remote Control Guest computer could for example be operated by an IT administrator providing IT support. When the IT administrator later wants to remotely control the student computer, the administrator must type the password before being granted access.

See Also
Remotely manage student computers

11.3.3 Protection Password

Use the Protection Password dialog box to define whether password protection is used at all in the Student module and which types of files should be protected.
## Dialog box help information

<table>
<thead>
<tr>
<th>Change Protection Password</th>
<th>Define and change password.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protection Password required for</td>
<td>Define the areas in which the user should be asked for a password</td>
</tr>
</tbody>
</table>

### Note
Password protection is only enabled if you have in fact defined a password. Click the **Change Protection Password** button to specify a password.

<table>
<thead>
<tr>
<th>Protect security configuration files</th>
<th>Protect by Protection Password only</th>
<th>Security configuration files are protected with a password provided that a password has in fact been defined.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protect files when connected</td>
<td>Protect files when connected</td>
<td>Protects your files from being manipulated while remotely controlled. The student is allowed to manipulate the files.</td>
</tr>
<tr>
<td>Protect files when connected and class joined</td>
<td>Protect files when connected and class joined</td>
<td>Protect files on the student computer at all times during a class. This protects your files from being manipulated while remotely controlled. Neither student nor teacher are allowed to manipulate the files.</td>
</tr>
</tbody>
</table>
### 11.3.4 Student Login options

The student computer can be identified in a number of different ways on the teacher computer:

<table>
<thead>
<tr>
<th>Identify Student by</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows login name</td>
<td>The name you use to log on to Windows when you start your computer. Example: js</td>
</tr>
<tr>
<td>Windows login name and \Domain</td>
<td>Same as above only prefaced with the name of the domain you belong to. Example: europe\js</td>
</tr>
<tr>
<td>Windows full name</td>
<td>You full name as registered in Windows. Example: John Smith</td>
</tr>
<tr>
<td>Windows full name and \Domain</td>
<td>Same as above only prefaced with the name of the domain you belong to. Example: europe\John Smith</td>
</tr>
<tr>
<td>Computer name</td>
<td>The computer name used by Windows to identify the computer on the network. Example: JS0001 Using computer name can be useful if for example the student computer is in a computer lab and several students share the same computer.</td>
</tr>
<tr>
<td>Computer name and \Domain</td>
<td>Same as above only prefaced with the name of the domain you belong to. Example: europe\JS0001</td>
</tr>
<tr>
<td>Prompt for login name</td>
<td>Typically your actual name is used. This is useful if students bring their own computers and the student names are known, or if the classroom is virtual.</td>
</tr>
<tr>
<td>Login as:</td>
<td>When this option is selected, the actual name used to log on must be specified. Windows environment variables can be used, for example %username% or %userprofile%.</td>
</tr>
</tbody>
</table>

**Tip**

When you select an option, the actual choice is shown in the dialog box so that you can verify that this is actually the name you intended to choose.
11.4 Student dialog boxes

11.4.1 Student window

The Student module window has four tab pages used to present different types of status information.

- **General tab**
  
  Shows current status.

  **Status**
  
  A student computer can either be waiting for a class or be in a class, for example **Waiting for <class name>**, or **In <class name>** where <class name> is the actual name of the class.

  **Computer and Student Login Name**
  
  The student computer name and the student login name.
  
  For an overview of the different student login name options, see **Student login options**.

  **Connection Method**
  
  How the student computer connects to a class.
  
  For an overview of the different ways a student computer can connect to a class, see **Class options**.

- **Class tab**
  
  Shows the student computers and their status in the present class. Absent students are not shown.

- **Messages tab**
  
  Lists messages sent to you. Double-click a message to open it.

- **Recordings tab**
  
  Lists the recordings that were sent to you during lessons you have attended.

  - Right-click to copy, rename, delete or organize recordings.

  - Double click a recording to play it.
Index

A
About 82
Advanced Display Info 94
Communication Info 92
access
enable 96
access key 50
action 22
actions
change stealth mode 29, 56
lock keyboard and mouse 56
add students to group 27
advanced audio settings 75
Advanced Display Info 99
allow
applications 42
Internet 42
apply policy 45
assistant teacher 29, 55
assisting students 20
attention 14, 64
audio/video chat 54, 75
authentication 79
available for any class 69
available students 25
award negative 40

B
background picture 52
block Internet access 43
block programs 42
browse for classes 69
button size 50

C
change stealth mode 29, 56
demonstrate 11, 12
demonstration 12
deny
applications 42
demonstrate 11, 12
demonstration 12
deny
applications 42
deny
  Internet 42
deny access 44
Destructive Actions 96
discussion types 82
display
  customize 52
distribute files 16, 85, 87
Drop-down List 33
E
edit policy 86
enable access 96
end control 55
end demonstration 13
end workgroup session 29
equalizing weights 41
Essay 33
export test results 18
F
file manager poptions
  confimation 89
  layout 89
  transfer 89
files 83
folder
  private 39
  public 39
G
General Tab 99
get files 83, 87
group 27
groups 4
Guest access 96
H
help request 55
hidden mode 9
hide 44
hide a program 20
hide mode 29, 56
I
image on shared drive 89
import 85
  lesson plan 46
test 46
improve communication and connectivity 76
Internet address 42
invitation 25, 54
invite a student 25
J
join a class 54
K
keyboard shortcut 50
L
Label Image 33
large video files 11
lesson action 22
lesson plan
  copy 22
  create 22
  create lesson actions 22
delete 22
  manage lessons 22
  select lesson 22
lesson plan import 46
lock 14
locked keyboard and mouse 56
log off 28
lost connection 76
M
Match Image 33
Match Text 33
Messages Tab 99
moderated discussion 82
move a student computer 26
Multiple Choice 33
Index

N
navigate the ribbon 50
negative 40
Net Address 92
Netop Guest access 96
Netop Screen Image 59
NetOp Screen Video 59
new lesson 22
new policy
applications 42
Internet 42
normal mode 9

O
open discussion 82
Options
advanced audio settings 75
attention 64
audio/video chat 75
class 69
class server setup 71
connection 76
demonstrate 62
display 52
general 73
Help Request 96
policy 65
Protection 79, 96
protection, change password 79
run 63
sessions properties 66
sharing 79
Student Login 98
supervision 66
teacher 79
toolbar commands 81
web update 81
Ordering 33

P
performance improvement tip 11
personalize 48, 78
reset 51
policy 42, 45, 69
edit 86
port 93
ports to scan 65
print test results 18
private folder 39
profile 28, 52, 79
program
run 63
prohibit use of Internet 43
prohibit use of programs 42
Protection Password 96
proxy server 65
public folder 39

Q
Question and Answer 33
question passed 40
question weight 40, 41
questions 37

R
reapply policy 45
recording 23
rejoin class 45
release assistant teacher 29
remote control 55
rename commands 50
rename, reorganize or hide tabs 48, 78
request help 55
reset policy 45
reset tabs and groups 51
restore 51
run
test or program 18
run a program 63

S
scan 93
schedule web update 81
scoring
   award negative  40
   question passed  40
   question weight  40
   show answers grid  40
   test passed  40
screen shot  59
select a lesson  22
select class  25, 69
send files  85, 87
send recording to students  23
settings  38
shared drive  89
shortcut  50
show answers grid  40
startup policy  45, 69
stealth
   change stealth mode  29, 56
   startup options  29, 56
stealth mode  9
stop workgroup session  29
student assists teacher  29
student control
   class activity  20
   monitoring - cycling screens  20
   monitoring - thumbnails  20
   remote control  20
Student Information  94
student list  27
Student Security  96
student window  9
Student Window - Tabs  99
students joining a class  25
suppress student keyboard and mouse
survey  32, 40
System Info  99

T
   tab  18
      create new  48, 49, 78
      delete  48, 78
   hide  48, 49, 78
   rename  48, 49, 78
   reorganize  49
   teacher profile  28, 79
   test  32
      close test  54
      logon  54
      result  54
   Test Designer window
      Add Question  94
      Options  94
      Remove Question  94
      Score  94
      Style  94
   test import  46
   Test Monitor  18
   test passed  40
   Test Progress  18
   test questions  37
   test results
      export  18
      print  18
   test settings  38
   Test View  18
   Text Completion  33
   thumbnail  84
   thumbnails
      customize  52
   tip to improve performance  11
   tips
      test questions  37
      test settings  38
   toolbar commands  81
   toolbox  13

U
   Unauthorized Actions  96
   USB  46
   use class server  69
   user profile  79
Index

V
  video files  11
  Views buttons  52
  visible mode  9

W
  Web Update options  9
  weight exceptions  41
  wrong answer  40

X
  XLS  18